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Regulatory Compliance

Thermo Electron San Jose performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When your system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as follows:

•  EMC - Directive 89/336/EEC as amended by 92/31/EEC and 93/68/EEC
EMC Compliance has been evaluated by: U.L. Underwriter’s Laboratory Inc.

EMC issues have been evaluated by UNDERWRITERS LABORATORY, INC (UL)

Safety Compliance
•  Safety - Low Voltage Directive 73/23/EEC 

 EN61010-1:  2001    Compliance with safety issues is declared under Thermo Electron sole responsibility.
Please be aware that any changes that you make to your system may void compliance with one or more of these EMC 
and/or safety standards.
Making changes to your system includes replacing a part. Thus, to ensure continued compliance with EMC and safety 
standards, replacement parts should be ordered from Thermo Electron or one of its authorized representatives.

FCC Compliance Statement

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.

CAUTION: The USER shall read and understand the various precautionary and warning notes, signs and 
symbols contained inside this manual, pertaining to the SAFE USE and operation of this product, BEFORE 
proceeding to read the technical information about its characteristics and functionality.

EMC Certification

EN 55011 1998 EN 61000-4-3 2002
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1998, A14; 2000

EN 61000-4-4 1995, A1; 2001, A2; 
2001

EN 61000-3-3 1998 EN 61000-4-5 1995, A1; 2001

EN 61326-1 1998 EN 61000-4-6 1996, A1; 2001

EN 61000-4-2 2000 EN 61000-4-11 1994, A1; 2001
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Notice on Lifting and Handling of
Thermo Electron San Jose Instruments

For your safety, and in compliance with international regulations, the physical handling of this 
Thermo Electron San Jose instrument requires a team effort for lifting and/or moving the 
instrument. This instrument is too heavy and/or bulky for one person alone to handle safely.

Notice on the Proper Use of
Thermo Electron San Jose Instruments

In compliance with international regulations: If this instrument is used in a manner not 
specified by Thermo Electron San Jose, the protection provided by the instrument could be 
impaired.
70111AMff
TE SJ - 8 April 2003



WEEE Konformität
Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 
2002/96/EC erfüllen.  Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Electron hat Vereinbarungen getroffen mit Verwertungs-/Entsorgungsanlagen  in 
allen EU-Mitgliederstaaten und dieses Produkt muss durch diese Firmen 
wiederverwertet  oder entsorgt werden.  Mehr Informationen über die Einhaltung dieser 
Anweisungen durch Thermo Electron, die Verwerter und Hinweise die Ihnen nützlich 
sein können, die Thermo Electron Produkte zu identifizieren, die unter diese RoHS 
Anweisung fallen, finden Sie unter www.thermo.com/WEEERoHS. 

WEEE Compliance
This product is required to comply with the European Union’s Waste Electrical & 
Electronic Equipment (WEEE) Directive 2002/96/EC. It is marked with the following 
symbol:

Thermo Electron has contracted with one or more recycling/disposal companies in each 
EU Member State, and this product should be disposed of or recycled through them. 
Further information on Thermo Electron’s compliance with these Directives, the 
recyclers in your country, and information on Thermo Electron products which may 
assist the detection of substances subject to the RoHS Directive are available at 
www.thermo.com/WEEERoHS.
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Conformité DEEE
Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets 
d'Equipements Electriques et Electroniques (DEEE). Il est marqué par le symbole 
suivant:

Thermo Electron s'est associé avec une ou plusieurs compagnies de recyclage dans 
chaque état membre de l’union européenne et ce produit devrait être collecté ou recyclé 
par celles-ci. Davantage d'informations sur la conformité de Thermo Electron à ces 
directives, les recycleurs dans votre pays et les informations sur les produits Thermo 
Electron qui peuvent aider la détection des substances sujettes à la directive RoHS sont 
disponibles sur www.thermo.com/WEEERoHS. 
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Read This First

Welcome to the Thermo Electron, Finnigan™ TSQ Quantum Ultra™ 
system! The TSQ Quantum Ultra is a member of the TSQ® family of 
Finnigan mass spectrometers.

This TSQ Quantum Ultra Getting Connected manual provides you with 
information on how to connect your TSQ Quantum Ultra system.

TSQ Quantum Ultra Getting Connected includes the following chapters:

Chapter 1:  Line Power, Vacuum System, Gases, and Ethernet 
Communication describes how to connect the TSQ Quantum Ultra to line 
power, to the forepump, to the nitrogen gas, to the argon gas, and to the 
data system computer.

Chapter 2:  Connecting Probes describes how to connect the 
TSQ Quantum Ultra to the ESI probe and APCI probe.

Chapter 3:  Control of Inlet Devices describes how to connect external 
devices, how to connect devices that require contact closure, and how to 
trigger external devices.

Chapter 4:  Connecting the Thermo Electron Finnigan Surveyor® LC 
System describes how to connect the TSQ Quantum Ultra Dsicovery to the 
Surveyor LC System.

Chapter 5:  Connecting the Thermo Electron Finnigan SpectraSYSTEM® 
describes how to connect the TSQ Quantum Ultra to the SpectraSYSTEM 
equipped with an autosampler, pump, and UV detector.

Chapter 6:  Connecting an HP Series LC describes how to connect the 
TSQ Quantum Ultra to the Hewlett-Packard® (HP) 1050, 1090, or 1100 
Series LC system.  It also describes how to install the PCI-GPIB PCB and 
install the GPIB software.

Chapter 7:  Connecting the Agilent® 1100 Series LC describes how to 
connect the TSQ Quantum Ultra to the Agilent 1100 Series LC system. 

Chapter 8:  Connecting the Waters LC describes how to connect the 
TSQ Quantum Ultra to the Waters Alliance® 2690 Separations Module 
and the Waters 2487 Dual λ Absorbance Detector.
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide iii



Preface
Chapter 9:  Connecting the Gilson 215 Liquid Handler describes how to 
connect the TSQ Quantum Ultra to the Gilson NEBULA Series™ 215 
Liquid Handler.

Chapter 10:  Connecting the SS420x Analog-to-Digital Interface Kit 
describes how to install and configure the SS420x.

Chapter 11:  Connecting the 4-Port Serial PCB describes how to install the 
4-Port Serial PCB.

Chapter 12:  Making Plumbing Connections to Run Samples on the 
TSQ Quantum Ultra describes how to connect plumbing for H-ESI/MS 
and APCI/MS sample introduction into the TSQ Quantum Ultra 
mass spectrometer.
iv Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide Thermo Electron Corporation



Preface
Changes to the Manual and Online Help
Changes to the
Manual and
Online Help

To suggest changes to this manual or the online Help, please send your 
comments to:

Editor, Technical Publications
Thermo Electron San Jose
355 River Oaks Parkway
San Jose, CA 95134-1991
U.S.A.

You are encouraged to report errors or omissions in the text or index. 
Thank you.
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide v



Preface
Abbreviations
Abbreviations The following abbreviations are used in this and other manuals and in the 
online Help.

A ampere
ac alternating current
ADC analog-to-digital converter
ASCII American Standard Code for Information 

Interchange
AU absorbance unit
b bit
B byte (8 b)
baud rate data transmission speed in events per second
°C degrees Celsius
CD compact disc
CD-ROM compact disc read-only memory

cfm cubic feet per minute
cm centimeter
cm3 cubic centimeter
CPU central processing unit (of a computer)
<Ctrl> control key on the terminal keyboard
d depth
DAC digital-to-analog converter
dc direct current
<Enter> enter key on the terminal keyboard
°F degrees Fahrenheit
ft foot
FTP file transfer protocol
g gram
G giga (109)
GND electrical ground
GPIB general-purpose interface bus
h hour
h height
HPLC high-performance liquid chromatograph
HV high voltage
Hz hertz (cycles per second)
ID inside diameter
vi Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide Thermo Electron Corporation



Preface
Abbreviations
IEC International Electrotechnical Commission
IEEE Institute of Electrical and Electronics Engineers
in. inch
k kilo (103, 1000)
K kilo (210, 1024)
kg kilogram
l length
L liter
LAN local area network
lb pound
LC liquid chromatograph; liquid chromatography
LC/MS liquid chromatograph / mass spectrometer
LED light-emitting diode
µ micro (10-6)
m meter
m milli (10-3)
M mega (106)
MB megabyte (1048576 bytes)
min minute
mL milliliter
mm millimeter
nm nanometer
NIST National Institute of Standards and Technology 

(USA)
OD outside diameter
Ω ohm
Pa pascal
PCB printed circuit board
P/N part number
P/P peak-to-peak voltage
ppm parts per million
psi pounds per square inch
RAM random access memory
RF radio frequency
RMS root mean square
ROM read-only memory
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide vii



Preface
Abbreviations
RS-232 industry standard for serial communications
s second
TCP/IP transmission control protocol / Internet protocol
Torr torr
URL uniform resource locator
V volt
V ac volts alternating current
V dc volts direct current
vol volume
w width
W watt
WWW World Wide Web

Note Exponents are written as superscripts. In the corresponding online 
Help, exponents are sometimes written with a caret (^) or with e 
notation because of design constraints in the online Help. For example:
MSn (in this manual) MS^n (in the online Help)
105 (in this manual) 10^5 (in the online Help) 
viii Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide Thermo Electron Corporation



Preface
Typographical Conventions
Typographical
Conventions

Typographical conventions have been established for Thermo Electron 
San Jose manuals for the following:

• Data input

• Boxed information

• Topic headings

Data Input Throughout this manual, the following conventions indicate data input and 
output by way of the computer: 

• Messages displayed on the screen are represented by capitalizing the 
initial letter of each word and by italicizing each word.

• Input that you enter by keyboard is enclosed in double or single quotes. 

• For brevity, expressions such as “choose File > Directories” are used 
rather than “pull down the File menu and choose Directories.”

• Any command enclosed in angle brackets < > represents a single 
keystroke. For example, “press <F1>” means press the key labeled F1.

• Any command that requires pressing two or more keys simultaneously is 
shown with a plus sign connecting the keys. For example, “press 
<Shift> + <F1>” means press and hold the <Shift> key and then press 
the <F1> key.

• Any button that you click the screen is represented in boldface letters 
and a different font. For example, “click Close”.

Boxed Information Information that is important but not part of the main flow of text is 
displayed in a box such as the one below.

Boxed information can be of the following types:

• Note – information that can affect the quality of your data. In addition, 
notes often contain information that you might need if you are having 
trouble.

• Tip – helpful information that can make a task easier.

Note Boxes such as this are used to display information. 
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide ix



Preface
Typographical Conventions
• Important – critical information that can affect the quality of your data.

• Caution – information necessary to protect your instrument from 
damage.

• CAUTION – hazards to human beings. Each CAUTION is 
accompanied by a CAUTION symbol. Each hardware manual has a 
blue CAUTION sheet that lists the CAUTION symbols and their 
meanings.

• DANGER – laser-related hazards to human beings. It includes 
information specific to the class of laser involved. Each DANGER is 
accompanied by the international laser radiation symbol.

Topic Headings The following headings are used to show the organization of topics within a 
chapter:

Chapter 1 Chapter Name

Second Level Topics

Third Level Topics

Fourth Level Topics
x Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide Thermo Electron Corporation



Preface
Reply Cards
Reply Cards Thermo Electron San Jose manuals contain one or two reply cards. All 
manuals contain a Customer Registration / Reader Survey card and some 
contain a Change of Location card. These cards are located at the front of 
each manual.

The Customer Registration / Reader Survey card has two functions. First, 
when you return the card, you are placed on the Thermo Electron San Jose 
mailing list. As a member of this list, you receive application reports and 
technical reports in your area of interest, and you are notified of events of 
interest, such as user meetings. Second, it allows you to tell us what you like 
and do not like about the manual. 

The Change of Location card allows us to track the whereabouts of the 
instrument. Fill out and return the card if you move the instrument to 
another site within your company or if you sell the instrument. 
Occasionally, we need to notify owners of our products about safety or other 
issues.
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Preinstallation Requirements Guide xi





Chapter 1 Line Power, Vacuum System, 
Gases, and Ethernet Communication 

The TSQ Quantum Ultra™ is a member of the TSQ® family of Finnigan™ 
mass spectrometers. This chapter describes how to connect the 
TSQ Quantum Ultra to line power, to the forepump, to the necessary gases, 
and to the data system computer.

The following topics are discussed in this chapter:

• Connecting the TSQ Quantum Ultra to Line Power

• Connecting the TSQ Quantum Ultra to the Forepumps

• Connecting Gases to the TSQ Quantum Ultra

• Connecting the TSQ Quantum Ultra to the Data System Computer
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Getting Connected 1-1



Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting the TSQ Quantum Ultra to Line Power
Connecting the
TSQ Quantum Ultra to

Line Power

To connect the TSQ Quantum Ultra to line power, proceed as follows: 

1. Locate the Main Power circuit breaker switch on the TSQ Quantum 
Ultra Power Entry Module. 

2. Turn the circuit breaker switch to the Off (O) position.

3. Locate the Electronics switch and the Vacuum switch near the Main 
Power circuit breaker and make sure that the switch is in the Service 
Mode position.

4. Connect the power cord from the Power In inlet located on the 
TSQ Quantum Ultra Power Entry Module, to the 230 V ac power 
source in your laboratory.

Caution If your local area is subject to power fluctuations or power 
interruptions, a power conditioning device or an uninterruptible power 
supply (UPS) should be installed in your laboratory. (Refer to the topic 
Power Conditioning Devices in the Finnigan TSQ Quantum Ultra 
Preinstallation Requirements Guide.) 
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting the TSQ Quantum Ultra to the Forepumps
Connecting the
TSQ Quantum Ultra to

the Forepumps

To connect the TSQ Quantum Ultra to the forepumps, proceed as follows:

1. Using a hose clamp (P/N 00108-09001), connect the 3.8 cm (1.5 in.) 
ID reinforced vacuum hose to the TSQ Quantum Ultra vacuum inlet. 
(The vacuum hose inlet is located on the left side panel.) 

2. Connect the 3.8 cm (1.5 in.) Tee (P/N 97055-20222) to the free end of 
the vacuum hose with a hose clamp (P/N 00108-09001).

3. Using hose clamps (P/N 00108-09001), connect the 3.8 cm (1.5 in.) 
ID reinforced vacuum hoses to the other branches of the Tee connector.

4. Connect a pump fitting adapter (P/N 00108-09005) to the free end of 
the vacuum hoses with a hose clamp (P/N 00108-09001).

5. Place a centering ring (P/N 00108-02011) on the flange of each 
forepump vacuum inlet.

6. Connect the vacuum hose (with the attached fitting adapter) to the 
pump vacuum inlet. Secure the hose to the pump using the KF20/25 
vacuum hardware clamp (P/N 00102-10020).

7. Use hose clamps (P/N 00108-09001) to connect the 2.5 cm (1 in.) ID 
blue exhaust hoses from the forepump exhaust ports to the pump 
exhaust system in your laboratory. The exhaust hoses should travel at 
floor level and should extend no more than two meters (78.5 in.) 
above the level of the forepumps.

8. Connect the forepumps to line power, as follows:

a. Locate the Main Power circuit breaker switch on the Power Entry 
Module and switch the circuit breaker to the Off (O) position.

Caution An efficient fume exhaust system is required for the 
proper operation of your forepumps. Most API applications will 
contribute to the accumulation of solvents in the forepumps. 
These solvents must be purged from the mechanical pump oil 
periodically by opening the ballast valve located on the top of 
the pump. When the ballast valve is opened, a large volume of 
volatile solvent waste might enter the fume exhaust system. 
Therefore, your fume exhaust system must be able to 
accommodate the effluent resulting from periodic purging. The 
frequency of the purging is dependent on the throughput of 
your system. 
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Getting Connected 1-3



Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting the TSQ Quantum Ultra to the Forepumps
b. Connect the power cords attached to the forepumps to the 
forepump outlets located on the Power Entry Module.
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting Gases to the TSQ Quantum Ultra
Connecting Gases to
the TSQ Quantum

Ultra

This topic describes how to connect the required gases to the 
TSQ Quantum Ultra. The following topics are included:

• Connecting Nitrogen Gas to the TSQ Quantum Ultra

• Connecting Argon Gas to the TSQ Quantum Ultra

Connecting Nitrogen Gas
to the TSQ Quantum Ultra

The TSQ Quantum Ultra requires high-purity (99%) nitrogen for the API 
sheath gas and auxiliary gas. Nitrogen gas usage can be quite high. 
Therefore, it is recommended that nitrogen gas be supplied from one of 
three sources as follows: a large, sealed, thermally insulated cylinder 
containing liquid nitrogen, from which the nitrogen gas is boiled off from 
the liquid; the largest nitrogen cylinder that can be practically used; or a 
nitrogen generator. The required gas pressure is 690 ± 140 kPa 
(100 ± 20 psi).

Connect nitrogen gas to the TSQ Quantum Ultra, as follows: 

1. Connect an appropriate length of 1/4-in. ID Teflon® tubing with a 
brass Swagelok®-type 1/4-in. nut (P/N 00101-12500) and a 2-piece 
brass 1/4-in. ferrule [P/N 00101-10000 (front), P/N 00101-04000 
(back)] to the nitrogen source. See Figure 1-1 for the proper orientation 
of the fitting and ferrule.

2. Connect the opposite end of the Teflon tubing to the TSQ Quantum 
Ultra press-in fitting labeled NITROGEN IN located on the left side 
panel of the TSQ Quantum Ultra. Connect the tubing by aligning the 
Teflon tubing with the opening in the fitting and firmly pushing the 
tubing into the fitting until the fitting holds the tubing securely.

Connecting Argon Gas to
the TSQ Quantum Ultra

The TSQ Quantum Ultra requires argon gas for the collision induced 
dissociation (CID) gas. The argon gas must be ultra-high purity (99.999%) 
with less than 1.0 ppm each of water, oxygen, and total hydrocarbons. The 
argon gas source should be one 245-ft3 tank with a Matheson #3104C 
Series regulator or an equivalent tank and regulator. The required gas 
pressure is 140 ± 70 kPa (20 ± 10 psi).

Connect argon gas to the TSQ Quantum Ultra, as follows: 

1. Connect an appropriate length of 1/8-in. ID Teflon tubing with a brass 
Swagelok-type 1/8-in. nut (P/N 00101-15500) and a 2-piece brass 
1/8-in. ID ferrule [P/N 00101-08500 (front), P/N 00101-2500 (back)] 
to the argon gas regulator. (See Figure 1-1 for the proper orientation of 
the fitting and ferrule.)
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting Gases to the TSQ Quantum Ultra
2. Connect the opposite end of the Teflon tubing with a brass 
Swagelok-type 1/8-in. nut (P/N 00101-15500) and a 2-piece brass 
1/8-in. ID ferrule [P/N 00101-08500 (front), P/N 00101-2500 (back)] 
to the ARGON IN inlet located on the left side panel of the 
TSQ Quantum Ultra. (See Figure 1-1 for the proper orientation of the 
fitting and ferrule.)

Figure 1-1. Proper orientation of the Swagelok-type nut and two-piece ferrule

GAS HOSE

SWAGELOK-TYPE NUT

FRONT FERRULE

BACK FERRULE
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Line Power, Vacuum System, Gases, and Ethernet Communication
Connecting the TSQ Quantum Ultra to the Data System Computer
Connecting the
TSQ Quantum Ultra to

the Data System
Computer

The TSQ Quantum Ultra data system consists of a computer, a monitor, 
and an optional printer. The TSQ Quantum Ultra communicates with the 
data system computer through an Ethernet cable. To connect the Ethernet 
cable, proceed as follows: 

1. Connect a category five network (Ethernet) cable (P/N 00302-01838) 
to the Ethernet 100 Base T connector located on the TSQ Quantum 
Ultra Power Entry Module.

2. Connect the opposite end of the Ethernet cable to the 10/100BaseT 
Ethernet switch (P/N 00825-01015) provided with the TSQ Quantum 
Ultra.

3. Connect a second Ethernet cable (P/N 00302-01838) from the 
Ethernet switch to the Ethernet card on the data system computer 
labeled Surveyor LC and TSQ Quantum Ultra.

4. Plug in the power supply for the Ethernet switch.
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Chapter 2 Connecting Probes 

This chapter describes how to connect an ion source probe to the 
TSQ Quantum Ultra.

The following topics are discussed in this chapter:

• Connecting the H-ESI Probe to the TSQ Quantum Ultra

• Connecting the APCI Probe to the TSQ Quantum Ultra
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Connecting the H-ESI Probe to the TSQ Quantum Ultra
Connecting the H-ESI
Probe to the TSQ

Quantum Ultra

Connect liquid lines to the H-ESI probe as follows:

1. If necessary, install the Ion Max source housing onto the TSQ Quantum 
Ultra as described in the Finnigan Ion Max API Source Hardware 
Manual. Be sure to connect the 1-in. ID Tygon® tubing (P/N 
00301-22922) to the source housing drain fitting and insert the exit end 
of the tubing into a waste container. Ideally, the waste container should 
be vented to a fume exhaust system.

2. Install the H-ESI probe in the Ion Max housing as described in 
Chapter 3: “Removing and Installing the H-ESI Probe” in the Finnigan 
H-ESI Probe Operator’s Manual.

3. Install liquid lines, as necessary, between the divert/inject valve, the LC 
system, the syringe pump, and the grounding union, as is appropriate 
for your application, in accordance with the associated drawing in the 
topic “Plumbing Connections for H-ESI/MS” on page 12-4.

Caution Prevent solvent waste from backing up into the API source and 
mass spectrometer. Always ensure that the PVC drain tubing is above 
the level of liquid in the waste container. 

Caution Do not vent the PVC drain tube (or any vent tubing connected 
to the waste container) to the same fume exhaust system to which you 
have connected the forepumps. The analyzer optics can become 
contaminated if the API source drain tube and the (blue) exhaust tubing 
from the forepumps are connected to the same fume exhaust system.

Your laboratory must be equipped with at least two fume exhaust 
systems. Route the (blue) exhaust tubing from the forepumps to a 
dedicated fume exhaust system. Route the PVC drain tube from the API 
source to the waste container. Vent the waste container to a dedicated 
fume exhaust system. 
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Connecting the APCI
Probe to the TSQ

Quantum Ultra

Connect liquid lines to the APCI probe as follows:

1. If necessary, install the Ion Max source housing and APCI probe onto 
the TSQ Quantum Ultra as described in the Finnigan Ion Max API 
Source Hardware Manual. Be sure to connect the 1-in. ID Tygon 

tubing (P/N 00301-22922) to the source housing drain fitting and 
insert the exit end of the tubing into a waste container. Ideally, the waste 
container should be vented to a fume exhaust system.

2. Install liquid lines, as necessary, between the divert/inject valve, the LC 
system, the syringe pump, and the sample inlet fitting on the APCI
probe, as is appropriate for your application, in accordance with the 
associated drawing in the topic “Plumbing Connections for APCI/MS” 
on page 12-11.

Caution Prevent solvent waste from backing up into the API source and 
mass spectrometer. Always ensure that the PVC drain tubing is above 
the level of liquid in the waste container. 

Caution Do not vent the PVC drain tubing (or any vent tubing 
connected to the waste container) to the same fume exhaust system to 
which you have connected the forepumps. 

Note If you need to install or replace the APCI fused-silica sample tube, 
refer to the topic “Maintaining the APCI Probe” in the Finnigan Ion 
Max API Source Hardware Manual for instructions. 
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Chapter 3 Control of External Devices

This chapter describes how to connect the TSQ Quantum Ultra to external 
devices.

The following topics are discussed in this chapter:

• External Devices Controlled by the Xcalibur Data System

• External Devices Not Controlled by the Xcalibur Data System
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External Devices
Controlled by the

Xcalibur Data System

The Xcalibur data system allows for the control of external devices (e.g., 
autosamplers, pumps, and detectors) from several manufacturers including 
Thermo Electron, Agilent, Waters, and Gilson. The TSQ Quantum Ultra 
can start data acquisition from an external device upon receiving a contact 
closure (closed contact or open contact) signal from the device. The 
TSQ Quantum Ultra receives contact closure signals through a 2-wire 
trigger cable (in kit P/N OPTON-21705) connected to the Start In TTL 
receptacle on the Power Entry Module. Figure 3-1 shows a simplified block 
diagram of the TSQ Quantum Ultra contact closures to an external device.

Table 3-1 lists the Xcalibur kits for various external devices.

Note The external device providing the start signal must have a good 
ground. Ground loops can cause problems. 

Caution The contact-closure interface on the Power Entry Module 
accepts a "start" signal from an external device such as a liquid 
chromatography pump or an autosampler. It is designed to accept a 
broad range of input signals, from 5V to 30V. However, applying a 
voltage greater than 30V might damage the contact-closure interface. 

Figure 3-1. Portion of the power entry module showing contact closures for the TSQ Quantum Ultra and 
an external device
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Thermo Elec
Table 3-1. Xcalibur kits for various external devices 

Part Number Description of Kit

OPTON-21705 Xcalibur Contact Closure Kit
(for devices not controlled by Xcalibur)
2-wire trigger cable
8-position screw connector

OPTON-21706 Xcalibur SpectraSystem Interface Kit
SpectraSystem 9.05 EPROM for SN4000
EPROM removal tool
Contact Closure Wiring Harness
2-wire trigger cable (contact closure)

OPTON-21707 Xcalibur Gilson Interface Kit
serial cable
2-wire trigger cable (contact closure)

OPTON-21709 Xcalibur Additional 4-Port Serial Kit
4-Port Serial PCB (PCI) and software
Quad DB9 male adapter

OPTON-21710 Xcalibur Waters Interface Kit
Waters serial I/F cable
2-wire trigger cable (contact closure)

OPTON-21711 Xcalibur HP 1100 Interface Kit
National Instruments PCI-GPIB PCB and software
HP GPIB cable, 2 m (3 each)
GPIB cable, 4 m (1 each)
HP 1100 External Contact Interface Board
HP 1100 External Contact Interface cable 

OPTON-21712 Xcalibur HP 1050 Interface Kit
National Instruments PCI-GPIB PCB and software
HP GPIB cable, 2 m (3 each)
GPIB cable, 4 m (1 each)
2-wire trigger cable (contact closure)

OPTON-21713 Xcalibur HP 1090 Interface Kit
National Instruments PCI-GPIB PCB
GPIB cable, 4 m (1 each)
2-wire trigger cable (contact closure)

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x main unit
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit
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External Devices Not
Controlled by the

Xcalibur Data System

External devices that are not controlled by the Xcalibur data system must be 
properly connected for contact closure and configured in the Xcalibur Run 
Sequence dialog box, as follows:

1. Connect the 2-wire trigger cable (in kit P/N OPTON-21705) from the 
TSQ Quantum Ultra power entry module to the contact closure 
terminal of the external device following the wiring scheme shown in 
Table 3-2. 

Table 3-2. Wiring the TSQ Quantum Ultra and an external device (not 
controlled by the Xcalibur data system) for contact closure 

2. Use the Xcalibur data system Run Sequence dialog box to configure the 
data system for the external device, as follows:

a. On the Xcalibur Home Page, choose View > Info View to open the 
Status Page (if it is not already open). 

b. In the Sequence Setup window make sure there is an active method 
and then choose Actions > Run Sequence or Actions > Run This 
Sample to open the Run Sequence dialog box. See Figure 3-2.

c. Click on Change Instruments to open the Change Instruments In 
Use dialog box. See Figure 3-3.

The TSQ Quantum Ultra should not be in the Start Instrument: Yes 
mode. Observe the Acquisition Options group box.

• If the TSQ Quantum Ultra MS is in the Start Instrument: Yes 
mode, go to step d.

• If the TSQ Quantum Ultra MS is not in the Start Instrument: 
Yes mode, click on OK to close the dialog box and go on to 
step 3.

Note The output (start) signal from the external device must be 
Normally Hi (+5 V) and go to Low momentarily to start data acquisition 
on the TSQ Quantum Ultra. If the external device cannot be configured 
to go from Normally Hi to Low momentarily, it cannot be used to trigger 
the TSQ Quantum Ultra. 

TSQ Quantum Ultra 
Power Entry Module

External Device 
Contact Closure Terminal

Start in Output (start) terminal 

Ground Ground terminal
3-4 Finnigan TSQ Quantum Ultra Getting Connected Thermo Electron Corporation



Control of External Devices
External Devices Not Controlled by the Xcalibur Data System
d. In the TSQ Quantum Ultra row of the Start Instrument column, 
click on Yes to change the mode to Off (field is blank), then click 
on OK to save the setting and close the dialog box.

3. In the Acquisition Options group box select the Start When Ready 
check box, then click on OK to save the settings, close the dialog box, 
and start the sequence or queue it. The instrument method is 
downloaded to the TSQ Quantum Ultra and the Status Page displays 
Waiting - Contact Closure.

4. Push the start button on the external device to start the external device, 
the TSQ Quantum Ultra, and the acquisition of data. 

Figure 3-2. Run Sequence dialog box 
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Figure 3-3. Change Instruments In Use dialog box

TSQ Quantum Ultra Is Not Selected as a 
Start Instrument
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Chapter 4 Connecting the Thermo 
Electron Finnigan Surveyor LC 
System

This chapter describes how to connect the TSQ Quantum Ultra to the 
Thermo Electron Finnigan Surveyor® LC system.

The following topics are discussed:

• Connecting the Hardware 

• Connecting the Plumbing
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Connecting the Hardware
Connecting the
Hardware

To connect the TSQ Quantum Ultra and data system to a Surveyor LC 
system equipped with a PDA detector, proceed as follows:

1. Stack the Surveyor modules in the following order from bottom to top: 
Surveyor MS Pump, Surveyor Autosampler, Surveyor PDA, and 
Surveyor Solvent Platform. See Figure 4-1.

2. Interconnect the Surveyor modules with the System Synchronization 
Wiring Harness (P/N F5049-010). The connectors on the System 
Synchronization Wiring Harness are labeled appropriately. 
See Figure 4-2 or Figure 4-3.

When the System Synchronization Wiring Harness is properly 
connected, one connector is not used. If you are using the MS Pump, 
the connector labeled LC Pump is not used; if you are using the LC 
Pump, the connector labeled MS Pump is not used.

Figure 4-1. Surveyor LC system

Solvent Platform

PDA Detector

Autosampler

MS Pump
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3. Connect the two pin end of the (P/N 7011-63136) cable to the 
Start In TTL receptacle on the TSQ Quantum Ultra power entry 
module.

4. Connect the other end of the Adapter LC/MS Interconnect to the 
System Synchronization Wiring Harness from step 2.

5. Connect the communication cable for the pump, as follows:

a. If you are using the Surveyor MS Pump, connect the 9-pin serial 
cable (P/N 72011-63008) from the pump RS-232 connector to the 
computer COM1 serial communication port (or another available 
port). See Figure 4-2.

b. If you are using the Surveyor LC Pump, connect an Ethernet cable 
(P/N F5048-020) from the Surveyor LC Pump ENET connector to 
the Ethernet hub (P/N 00825-01090). See Figure 4-3.

6. If you are using the Surveyor MS Pump, configure the COM1 serial 
port as follows. Otherwise, go to step 7.

a. Choose Start > Settings > Control Panel, then click on the 
System icon to open the System Properties dialog box.

b. Click on the Hardware tab, and then click on Device Manager.

c. Double-click on Ports (COM & LPT). The available ports are 
displayed below Ports (COM & LPT) in the Device Manager list.

d. Double-click on Communication Port (COM1) to display the 
Communication Port (COM1) Properties dialog box.

e. Click on the Port Setting tab.

f. Set the configuration parameters as follows:

Bits per Second 19200
Data Bits 8
Parity none
Stop Bits 1
Flow Control none

g. Click on OK to save the changes and close the Communication 
Port (COM1) Properties dialog box.

Note If your data system computer does not have a sufficient number of 
COM ports available, you might need to install the 4-port serial PCB as 
discussed in Chapter 11: “Connecting the 4-Port Serial PCB”. 
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h. Close the Device Manager window by clicking on the Close button 
in the title bar.

i. Click on OK to close the System Properties dialog box.

j. Restart the computer to enable the new settings. 

7. Connect a Category 5 network (Ethernet) cable (P/N 00302-01838) 
from the Surveyor PDA ENET connector to the Ethernet switch 
(P/N 00825-01015). See Figure 4-2 or Figure 4-3 for a wiring diagram.

8. Connect an Ethernet cable (P/N 00302-01838) from the Surveyor 
Autosampler ENET connector to the Ethernet switch.

9. Connect an Ethernet cable (P/N 00302-01838) from the Ethernet 
switch to the computer 3Com 3C900B-TX Ethernet card labeled 
Surveyor.

10. Connect an Ethernet cable (P/N 00302-01838) from the Ethernet 
switch to the TSQ Quantum Ultra Ethernet connection on the power 
entry module.
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Figure 4-3. Cable diagram for the Surveyor LC system with an LC Pump, TSQ Quantum Ultra, and data system
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Connecting the Thermo Electron Finnigan Surveyor LC System
Connecting the Hardware
11. Confirm that the 3Com 3C905B-TX Ethernet card is assigned to the 
TSQ Quantum Ultra and the Surveyor LC System as follows:

a. Choose Start > Settings > Control Panel, then double-click 
on the Network and Dial-up Connections icon to open the 
Network and Dial-up Connections dialog box.

b. Right-click on the Local Area Connection 3 icon and then choose 
Properties from the shortcut menu. The Local Area Connection 
Properties dialog box opens.

c. Select Internet Protocol (TCP/IP) from the Components Checked 
Are Used By This Connection list box. Click on Properties to 
open the Internet Protocol (TCP/IP) Properties dialog box.

d. Confirm that the IP address for the 3Com 3C905B-TX Ethernet 
card is 172.16.0.101. Reference Table 4-1.

e. Click on OK to close the Internet Protocol (TCP/IP) Properties 
dialog box, and then click on OK to close the Network dialog box.

Table 4-1. Data system computer configured with three (3) Ethernet cards

Slot Ethernet Card Use IP Address Subnet Mask

1 3Com 3C900B-TPC LCQ Series Instruments 10.0.0.101 255.255.255.0

2 3Com 3C905B-TX User’s Network 192.x.x.x 255.255.255.0

3 3Com 3C905B-TX TSQ Quantum Ultra and 
Surveyor LC System

172.16.0.101 255.255.0.0
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Connecting the
Plumbing

Plumb the Surveyor modules as follows:

1. The Surveyor Solvent Platform Accessory Kit (P/N SRVYR-TRAY) 
contains Teflon® tubing (P/N 3219-2004), Teflon solvent filters 
(P/N A4258-010), cap adapters (P/N A3191-010) and solvent caps 
(P/N A0343-010) that are used with the solvent bottles. Fit the solvent 
bottles appropriately and place them on the Surveyor Solvent Platform.

2. Feed the Teflon tubing from the solvent bottles through the guide slots 
located on the left side of the Surveyor modules. Connect the 
appropriate ends of the Teflon tubing to the inlets of the degassing 
chamber [black Delrin® nut (P/N 2803-0583), Tefzel® ferrule 
(P/N 2522-0284)] located on the MS Pump or LC Pump. Use the 
(black) tubing clamps located on the inside left of the Surveyor 
Autosampler to secure the tubing. See Figure 4-5 or Figure 4-6. 

3. Connect the autosampler to the pump as follows:

a. To connect the MS Pump, connect the stainless steel tubing that 
exits the Surveyor Autosampler column oven to the Surveyor MS 
Pump pulse dampener by using the Fingertight nut and ferrule set 
(P/N 00101-18088) that is included in the Surveyor MS Pump 
Accessory Kit. See Figure 4-5. 

b. To connect the LC Pump, connect the stainless steel tubing that 
exits the Surveyor Autosampler column oven to the Surveyor LC 
Pump line filter body on top of the purge manifold assembly by 
using the Fingertight nut and ferrule set (P/N 00101-18088) that is 
included in the Surveyor MS Pump Accessory Kit. See Figure 4-6. 

4. Connect the appropriate length of tubing from position 6 of the injector 
valve [Rheodyne nut (P/N 3522-0066), Rheodyne ferrule 
(P/N 2522-3830)] to the inlet of the LC Column. See Figure 4-7.

5. Connect the Teflon tubing (with fitting and ferrule) from the wash 
bottle to the syringe valve.

6. Verify that the LC column is mounted properly. The flow of solvent is 
from the injector valve through the LC column and into the PDA flow 
cell. The Surveyor LC System flow cell mounts in the detector in only 
one direction. Carefully position the flow cell in the mounting bracket 
to determine the proper mounting orientation. Connect the red PEEK 

Note Each numbered step in the procedure corresponds to a highlighted 
number in Figure 4-4. 
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tubing from the outlet of the LC column to the inlet (left end) of the 
Surveyor LC System flow cell. See Figure 4-8.

7. Connect the blue PEEK (outlet) tubing to the right end of the flow cell. 
The opposite end of the blue PEEK tubing is connected to the 
TSQ Quantum Ultra. See Figure 4-8. 

Note You need to configure the modules of your Surveyor LC System 
before you run samples. Refer to the Surveyor hardware manuals for 
information on configuring the modules. 

Figure 4-4. Surveyor LC system (with MS Pump) plumbing
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Figure 4-5. Surveyor MS Pump plumbing

Figure 4-6. Surveyor LC Pump plumbing

 From Autosampler

 From Autosampler
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Figure 4-7. Surveyor Autosampler plumbing 

Figure 4-8. Surveyor LC System plumbing, showing the flow cell
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Chapter 5 Connecting the Thermo 
Electron Finnigan SpectraSYSTEM 

The Xcalibur data system allows control of the Thermo Electron Finnigan 
SPECTRASYSTEM® 1 with autosampler (AS3000, AS3500), pump (P2000, 
P4000), and UV detector (UV2000, UV6000LP).

The following topics are discussed in this chapter:

• Connecting the TSQ Quantum Ultra to a SPECTRASYSTEM 
equipped with a UV2000 detector

• Connecting the TSQ Quantum Ultra to a SPECTRASYSTEM 
equipped with a UV6000LP detector

• Configuring the Autosampler and Pump

Table 5-1 lists the Xcalibur kit used with the SPECTRASYSTEM.

Table 5-1. Xcalibur kit used with the SPECTRASYSTEM 

1 Formerly Thermo Separation Products (TSP) SPECTRASYSTEM

Part Number Description of Kit

OPTON-21706 Xcalibur SPECTRASYSTEM Interface Kit
SPECTRASYSTEM 9.05 EPROM for SN4000
EPROM removal tool
Contact Closure Wiring Harness
2-wire trigger cable (contact closure)
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Table 5-2 lists the Xcalibur supported firmware for the SPECTRASYSTEM.

Table 5-2. Xcalibur supported firmware versions for the SPECTRASYSTEM

*To obtain the firmware version for a module, push the <MENU> key on the keypad, then use the < _ > key to 

select TESTS. Press the <ENTER> key twice to display the Software Version.

Table 5-3 lists the reference manuals for the SPECTRASYSTEM.

Table 5-3. SPECTRASYSTEM reference manuals

Module Model Number Firmware Version*

Binary pump P2000 4.03

Quaternary pump P4000 4.04

Autosampler AS3000/3500 3.44

UV/VIS detector UV2000 3.13

Photo diode array detector UV6000LP 1.00

Serial interface SN4000 9.05

Module Model Number Reference Manual

Binary pump P2000 SPECTRASYSTEM & SPECTRASERIES Gradient Pump Reference 
Manual

Quaternary pump P4000 SPECTRASYSTEM & SPECTRASERIES Gradient Pump Reference 
Manual

Autosampler AS3000/3500 SPECTRASYSTEM & SPECTRASERIES Autosampler Reference 
Manual

UV/VIS detector UV2000 SPECTRASYSTEM UV/VIS Detector Reference Manual

Photo diode array 
detector

UV6000LP UV6000LP Detector Reference Manual
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Connecting to a SpectraSYSTEM Equipped with UV2000 Detector
Connecting to a
SpectraSYSTEM

Equipped with UV2000
Detector

For additional information about your SPECTRASYSTEM modules refer to 
the manuals listed in Table 5-3.

To connect the TSQ Quantum Ultra to a SPECTRASYSTEM equipped with 
a UV2000 detector, proceed as follows:

1. Interconnect the pump, autosampler, and the UV2000 detector with 
the Contact Closure Wiring Harness. Follow the wiring scheme shown 
in Figure 5-1.

2. Connect the SN4000 (P/N A3625-073) to the pump, autosampler, 
UV2000 detector, and the data system computer, as follows. See 
Figure 5-1.

a. Turn the SN4000 power switch to Off and disconnect the 12 V dc 
power supply.

b. Turn the SN4000 upside down to access the four Phillips-head 
screws that secure the top cover to the case.

c. Remove the screws and slide the top cover off to expose the SN4000 
PCB and the RJ11 and RJ45 ports.

d. Verify that the EPROM firmware version 9.05 (P/N A4636-129) is 
installed in socket U12 located on the SN4000 PCB. Sockets U11, 
U28, and U29 should be empty. Verify that the correct firmware is 
installed in the pump, autosampler, and UV detector. (Refer to 
Table 5-2 on page 5-2.)

e. Connect one RJ11 6-pin, 4-wire cable from the PUMP port located 
on the SN4000 PCB to the COMM port located on the rear of the 
pump. (Route all cables through the access hole located in the rear 
panel of the SN4000.)

f. Connect another RJ11 6-pin, 4-wire cable from the A/S port 
located on the SN4000 PCB to the COMM port located on the 
rear of the autosampler.

g. Connect a third RJ11 6-pin, 4-wire cable from the DET 1 port 
located on the SN4000 PCB to the COMM port located on the 
rear of the UV2000 detector.

Caution Before you remove the top cover of the SN4000, turn the 
power switch located on the rear of the SN4000 to Off, and disconnect 
the 12 V dc power supply. 
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Figure 5-1. Schematic diagram showing the cable connections for the TSQ Quantum Ultra and a SPECTRASYSTEM equipped with a pump, autosampler, and UV2000 detector
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Connecting the Thermo Electron Finnigan SpectraSYSTEM
Connecting to a SpectraSYSTEM Equipped with UV2000 Detector
h. Connect an RJ45 8-pin, 8-wire cable from the COM port located 
on the SN4000 PCB to an RJ45 to DB9 adapter.

i. Connect the DB9 adapter and the attached cable to the RS-232 
port (labeled A) located on the rear of the data system computer. 

j. Reinstall the SN4000 top cover and mounting screws.

k. Reconnect the power cable from the 12 V dc power supply to the 
Power In inlet located on the rear of the SN4000.

3. Connect the TSQ Quantum Ultra and the autosampler for contact 
closure, as follows: Connect the 2-wire trigger cable (in kit P/N 
OPTON-21706) from the TSQ Quantum Ultra power entry module 
to the contact closure terminal located on the rear of the autosampler 
following the wiring scheme shown in Figure 5-1.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the SN4000 to COM1 (port A) of 
the data system computer, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP SN4000 button. The TSP SN4000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP SN4000 button in the Configured 
Devices group box. Xcalibur opens the TSP SN4000 Configuration 
dialog box. See Figure 5-2.

d. Select COM1 in the Serial Port list box, then click on OK to save 
the setting and close the dialog box.

Go to the topic “Configuring the Autosampler and Pump” on page 5-10.

Figure 5-2. SN4000 Configuration dialog box
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Connecting to a
SpectraSYSTEM

Equipped with
UV6000LP Detector

For additional information about your SPECTRASYSTEM modules, refer to 
the manuals listed in Table 5-3 on page 5-2.

To connect the TSQ Quantum Ultra to a SPECTRASYSTEM equipped with a 
UV6000LP detector, proceed as follows:

1. Interconnect the pump, autosampler, and UV6000LP with the Contact 
Closure Wiring Harness. Follow the wiring scheme shown in 
Figure 5-3.

2. Connect the SN4000 (P/N A3625-073) to the pump, autosampler, and 
data system computer, as follows. See Figure 5-3.

a. Turn the SN4000 power switch located on the rear of the module to 
Off and disconnect the 12 V dc power supply.

b. Turn the SN4000 upside down to access the four Phillips-head 
screws that secure the top cover to the case.

c. Remove the screws and slide the top cover off to expose the SN4000 
PCB and the RJ11 and RJ45 ports.

d. Verify that the EPROM firmware version 9.05 (P/N A4636-129) is 
installed in socket U12 located on the SN4000 PCB. Sockets U11, 
U28, and U29 should be empty. Verify that the correct firmware is 
installed in the pump, autosampler, and UV detector. (Refer to 
Table 5-2 on page 5-2.)

e. Connect one RJ11 6-pin, 4-wire cable from the PUMP port located 
on the SN4000 PCB to the COMM port located on the rear of the 
pump. (Route all cables through the access hole located in the rear 
panel of the SN4000.)

f. Connect another RJ11 6-pin, 4-wire cable from the A/S port located 
on the SN4000 PCB to the COMM port located on the rear of the 
autosampler.

g. Connect the RJ45 8-pin, 8-wire cable from the COM port located 
on the SN4000 PCB to an RJ45 to DB9 adapter.

h. Connect the DB9 adapter and the attached cable to the RS-232 port 
(labeled A) located on the rear of the data system computer.

i. Reinstall the SN4000 top cover and mounting screws.

Caution Before you remove the top cover of the SN4000, turn the 
power switch to Off, and disconnect the 12 V dc power supply. 
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Figure 5-3. Schematic diagram showing the cable connections for the TSQ Quantum Ultra and a SPECTRASYSTEM equipped with a pump, autosampler, and UV6000LP detector
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j. Reconnect the power cable from the 12 V dc power supply to the 
Power In inlet located on the rear of the SN4000.

3. Connect the UV6000LP detector to the data system computer, as 
follows. See Figure 5-3.

a. Connect an RJ45 8-pin, 8-wire cable to the RS-232 port located on 
the rear of the UV6000LP detector.

b. Connect the other end of the RJ45 8-pin, 8-wire cable to an RJ45 to 
DB9 adapter.

c. Connect the DB9 adapter and the attached cable to the RS-232 port 
(labeled A) located on the rear of the data system computer.

4. Connect the TSQ Quantum Ultra and the autosampler for contact 
closure, as follows: Connect the 2-wire trigger cable (in kit P/N 
OPTON-21706) from the TSQ Quantum Ultra power entry module to 
the contact closure terminal located on the rear of the autosampler 
following the wiring scheme shown in Figure 5-3.

5. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the SN4000 to COM1 (port A) or 
another available port of the data system computer, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP SN4000 button. The TSP SN4000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP SN4000 button in the Configured 
Devices group box. Xcalibur opens the SN4000 Configuration 
dialog box. See Figure 5-4.

d. Select COM1 (or the port that you used) in the Serial Port list box, 
then click on OK to save the setting and close the dialog box.

Note If your data system computer has too few serial ports for your 
needs, you might need to install the 4-port serial PCB as discussed in 
Chapter 11: “Connecting the 4-Port Serial PCB”. 
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6. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the UV6000LP to an empty com 
port, such as COM3, of the data system computer, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP UV6000 button. The TSP UV6000 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the TSP UV6000 button in the Configured 
Devices group box. Xcalibur opens the UV6000 Configuration 
dialog box. See Figure 5-5.

d. Select the port to which the UV6000LP is attached (in this case 
COM3) in the Serial Port list box, then click on OK to save the 
setting and close the dialog box.

Go to the next topic: “Configuring the Autosampler and Pump”.

Figure 5-4. SN4000 Configuration dialog box

Figure 5-5. UV6000 Configuration dialog box
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Configuring the
Autosampler and

Pump

To configure the autosampler and pump, proceed as follows:

1. Configure the autosampler for SpectraNet communication, as follows:

a. Turn on the pump, autosampler, and UV detector.

b. Turn on the SN4000.

c. After the autosampler power-up sequence is complete, press 
<MENU> on the autosampler keypad, then select 
/OPTIONS/Configurations/ to access the Configurations Menu.

d. Move the cursor to the Mode field, and use the <+> and the <−> 
keys to select SpectraNet. Then, press <ENTER> to accept the field 
value and exit the Configuration Menu.

2. Configure the autosampler for contact closure, as follows:

a. Press <MENU> on the autosampler keypad, then select 
/OPTIONS/Input Polarity/ to access the Input Polarity Menu.

b. Move the cursor to the Pump Ready Active field, and use the <+> 
and the <−> keys to select Hi or Lo. Both the autosampler and the 
pump must have the same polarity. Then, press <ENTER> to accept 
the field value and exit the Configuration Menu.

3. Configure the pump for contact closure, as follows:

a. Press <MENU> on the pump keypad, then select 
/OPTIONS/More/ to access the More Menu.

b. Move the cursor to the Ready Output Active field, and use the <+> 
and the <−> keys to select Hi or Lo. Both the autosampler and the 
pump must have the same polarity. Then press <ENTER> to accept 
the field value and exit the Configuration Menu.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
configure the autosampler and pump, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the TSP Autosampler button. The TSP Autosampler button is 
copied to the Configured Devices group box and is displayed as a 
Configured Devices button.
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c. Double-click on the TSP Autosampler button in the Configured 
Devices group box. Xcalibur opens the TSP Autosampler 
Configuration dialog box. See Figure 5-6.

d. Click on Autoconfigure to configure the autosampler, and then 
click on OK to save the settings and close the dialog box.

e. Scroll through the Available Devices group box and double-click on 
the TSP P4000 (or TSP P2000) button. The TSP P4000 button is 
copied to the Configured Devices group box and is displayed as a 
Configured Devices button.

f. Double-click on the TSP P4000 button in the Configured Devices 
group box. Xcalibur opens the Pump Configuration dialog box. See 
Figure 5-7.

g. Click on Autoconfigure to configure the pump, and then click 
on OK to save the settings and close the dialog box.

Figure 5-6. Autosampler Configuration dialog box

Figure 5-7. Pump Configuration dialog box
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Chapter 6 Connecting an HP Series LC 

The Xcalibur data system allows control of the Hewlett-Packard® (HP) 
1050, 1090, or 1100 Series LC.

The following topics are discussed in this chapter:

• Connecting the TSQ Quantum Ultra to an HP 1050 Series LC

• Connecting the TSQ Quantum Ultra to an HP 1090 Series LC

• Connecting the TSQ Quantum Ultra to an HP 1100 Series LC

• Installing and Configuring the PCI-GPIB Hardware

Table 6-1 lists the Xcalibur kits used with the HP Series LC.

Table 6-1. Xcalibur kits used with HP LC equipment

Part Number Description of Kit

OPTON-21711 Xcalibur HP 1100 Interface Kit
National Instruments PCI-GPIB PCB and software
HP GPIB cable, 2 m (3 each)
GPIB cable, 4 m (1 each)
HP 1100 External Contact Interface Board
HP 1100 External Contact Interface cable 

OPTON-21712 Xcalibur HP 1050 Interface Kit
National Instruments PCI-GPIB PCB and software
HP GPIB cable, 2 m (3 each)
GPIB cable, 4 m (1 each)
2-wire trigger cable (contact closure)

OPTON-21713 Xcalibur HP 1090 Interface Kit
National Instruments PCI-GPIB PCB
GPIB cable, 4 m (1 each)
2-wire trigger cable (contact closure)
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Connecting the TSQ
Quantum Ultra to an

HP 1050 Series LC

For additional information about the HP 1050 Series LC refer to the 
HP 1050 Series LC Getting It All Together manual.

Table 6-2 lists the Xcalibur supported firmware versions for the HP 1050 
Series LC.

Table 6-2. Xcalibur supported firmware versions for the HP 1050 Series LC

*To obtain the firmware version for an HP1050 pump or autosampler, push the <STATUS> key on 
the keypad, then push the <NEXT> key successively until the firmware version is displayed. To 
obtain the firmware version for an HP1050 VWD or MWD, push the <CTRL> key on the keypad, 
then push the <1> key, the <2> key, and <ENTER>-<ENTER>.

Table 6-3 lists the GPIB default addresses for the HP 1050 Series modules.

Table 6-3. GPIB default addresses for the HP 1050 Series modules

To connect the TSQ Quantum Ultra to an HP 1050 Series LC, proceed as 
follows:

1. Interconnect the modules of your HP 1050 Series LC following the 
instructions in the HP 1050 Series HPLC Modules Getting It All 
Together manual. 

2. If your data system computer is not equipped with a PCI-GPIB PCB 
(P/N 00012-27710), you need to install the PCB and load the GPIB 
diagnostic software. For instructions on how to install and configure the 
PCI-GPIB PCB refer to the topic “Installing and Configuring the 
PCI-GPIB Hardware” starting on page 6-16. For additional 
information about the PCI-GPIB PCB, refer to the manual that came 
with the PCB.

Module Firmware Version*

Quaternary pump 3.2

Autosampler 4.2

Variable wavelength detector 4.31

Multiple wavelength detector 3.1

Module Address

Quaternary pump 16

Autosampler 18

Variable wavelength detector 10

Multiple wavelength detector 17
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3. Connect the GPIB cable (in kit P/N OPTON-21712) from the GPIB 
connector (labeled HP-IB) located on the rear of the HP 1050 Series 
Autosampler to the GPIB connector located on the rear of the data 
system computer.

4. Connect the 2-wire trigger cable (in kit P/N OPTON-21712) from the 
TSQ Quantum Ultra power entry module to the 2-pin contact closure 
RELAY CONTACT 2 connector located on the rear of the HP 1050 
Series Autosampler following the wiring scheme shown in Table 6-4. 
See Figure 6-1.

Table 6-4. Wiring the TSQ Quantum Ultra and the HP 1050 Series Autosampler 
for contact closure

5. Use the Xcalibur data system Instrument Configuration dialog box to 
assign contact closure control to the HP 1050 Series Autosampler, as 
follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the HP1050 Autosampler button. The HP1050 Autosampler 
button is copied to the Configured Devices group box and is 
displayed as a Configured Devices button.

c. Double-click on the HP1050 Autosampler button in the 
Configured Devices group box. Xcalibur opens the HP1050 
Autosampler Configuration dialog box.

Figure 6-1. HP 1050 Series Autosampler rear panel RELAY CONTACT 2 
connector

HP 1050 Series Autosampler
RELAY CONTACT 2 Terminal

TSQ Quantum Ultra Power Entry Module
 

Top (30 V max) Start in (upper pin 8)

Bottom (30 V max ground) Ground (lower pin 7)

  RELAY CONTACT
2

30 V ~ 
max

30 V ~ 
max
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d. Click on the Communication tab to open the Communication 
page. See Figure 6-2.

e. Leave the Board spin box set to 1.

f. Confirm that the GPIB address in the Address spin box is the same 
as that listed for the HP 1050 Autosampler in Table 6-3. 

g. Select the Contact Board Installed check box, then click on OK to 
save the settings and close the dialog box.

6. Use the Xcalibur data system Instrument Setup to select the HP 1050 
Series Autosampler contact closure terminal and trigger type, as follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Home Page. Then, click on the Instrument Setup button to open 
the Instrument Setup window.

b. Click on the HP1050 AS button in the Instrument Setup viewbar to 
open the Instrument Setup view. Then, click on the Timed Events 
tab to open the Timed Events page. See Figure 6-3.

c. Click on the Settings text box to activate the Settings list box. Then, 
select Contact 2 in the list box.

d. Click on the Value text box to activate the Value list box. Then, 
select Closed in the list box.

Figure 6-2. HP1050 Autosampler dialog box
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e. Select File > Exit to close the Instrument Setup window. Xcalibur 
prompts you with the Save As dialog box, the File Summary 
Information Dialog box, and the File Save – Audit Trail dialog box.

Figure 6-3. Instrument Setup window, showing the HP 1050 Series Autosampler view with a portion 
of the Timed Events page displayed. The Timed Events page is for selecting the HP 1050 
Series Autosampler contact closure terminal and contact closure trigger type.
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Connecting the TSQ
Quantum Ultra to an

HP 1090 Series LC

For additional information about the HP 1090 Series LC refer to the 
HP 1090 Series II/L Liquid Chromatograph Installation Guide.

Table 6-5 lists the Xcalibur supported ROM level for the HP 1090 Series 
LC.

Table 6-5. Xcalibur supported ROM level for the HP 1090 Series LC

*To obtain the ROM level for the HP1090 LC, place the instrument in local mode by pressing 
<Esc>-<System on>. The display will power up and cycle between local and remote mode. Release 
the <Esc> key while the display is in local mode. With the HP1090 LC in local mode press 
<Shift>-<Ctrl>, then the <1> key and the <Enter> key to display the ROM level.

Table 6-6 lists the GPIB default address for the HP 1090 Series LC.

Table 6-6. GPIB default address for the HP 1090 Series LC

To connect the TSQ Quantum Ultra to an HP 1090 Series LC, proceed as 
follows:

1. If your data system computer is not equipped with a PCI-GPIB PCB 
(P/N 00012-27710), you need to install the PCB and load the GPIB 
diagnostic software. For instructions on how to install and configure the 
PCI-GPIB PCB refer to the topic “Installing and Configuring the 
PCI-GPIB Hardware” starting on page 6-16.

For additional information about PCI-GPIB PCB, refer to the manual 
that came with the PCB.

2. Connect a GPIB cable (in kit P/N OPTON-21712) from the GPIB 
connector (labeled HP-IB) located on the rear of the HP 1090 Series LC 
to the GPIB connector located on the rear of the data system computer.

3. Connect the 2-wire trigger cable (in kit P/N OPTON-21712) from the 
TSQ Quantum Ultra power entry module to the 2-pin contact closure 
EVENT 4 connector located on the rear of the HP 1090 Series LC 
following the wiring scheme shown in Table 6-7. See Figure 6-4.

Module Model Number ROM Level*

HP 1090 Series II/L 1090L F-3117

Module Address

HP 1090 14
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Table 6-7. Wiring the TSQ Quantum Ultra and the HP 1090 Series LC for contact 
closure

4. Switch the HP 1090 Series LC to remote mode, as follows:

a. On the HP 1090 Series LC keypad, press <System on> to turn on 
the instrument. The HP 1090 Series LC performs a self-test and 
displays method data ok, followed by local for approximately 2 s.

b. Press and hold <Esc>, with local still displayed, until the HP 1090 
Series LC displays remote. Release the <Esc> key. The instrument is 
now in remote mode.

5. Use the Xcalibur data system Instrument Configuration dialog box to 
assign contact closure control to the HP 1090 Series LC, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the HP1090 LC button. The HP1090 LC button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the HP1090 LC button in the Configured Devices 
group box. Xcalibur opens the HP1090 Configuration dialog box.

d. Click on the Communication tab to open the Communication 
page. See Figure 6-5.

Figure 6-4. HP 1090 Series LC rear panel EVENT 4 connector

HP 1090 Series LC 
EVENT 4 Contact Closure Terminal

TSQ Quantum Ultra Power Entry 
Module

 

Top (40 V dc) Start in (upper pin 8)

Bottom (0.1 V dc) Ground (lower pin 7)

Event 4

Contact Closure
40 V dc
0.1 A dc
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e. Leave the Board spin box set to 1.

f. Confirm that the GPIB address in the Address spin box is the same 
as that listed for the HP 1090 LC in GPIB default address for the 
HP 1090 Series LC. 

g. Select the Contact Board Installed check box, then click on OK to 
save the settings and close the dialog box.

6. Use the Xcalibur data system Instrument Setup to select the HP 1090 
Series LC contact closure terminal and trigger type, as follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Home Page. Then, click on the Instrument Setup button to open 
the Instrument Setup window.

b. Click on the HP1090 LC button in the Instrument Setup viewbar 
to open the Instrument Setup view. Then, click on the Timed 
Events tab to open the Timed Events page. See Figure 6-6.

c. Click on the Settings text box to activate the Settings list box. Then, 
select Contact 4 in the list box.

d. Click on the Value text box to activate the Value list box. Then, 
select Closed in the list box.

e. Select File > Exit to close the Instrument Setup window. Xcalibur 
prompts you with the Save As dialog box, the File Summary 
Information Dialog box, and the File Save – Audit Trail dialog box.

Figure 6-5. HP1090 LC dialog box
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Figure 6-6. Instrument Setup window, showing the HP1090 LC view with a portion of the Timed 
Events page displayed. The Timed Events page is for selecting the HP 1090 Series LC 
contact closure terminal and contact closure trigger type.
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Connecting the TSQ
Quantum Ultra to an

HP 1100 Series LC

For additional information about the HP 1100 Series LC refer to the 
HP 1100 Series LC reference manuals.

Table 6-8 provides a list of the Xcalibur supported firmware versions for the 
HP 1100 Series LC.

Table 6-8. Xcalibur supported firmware versions for the HP 1100 Series LC

*To obtain the firmware versions for the HP 1100 modules, verify that the HP 1100 Series modules are connected by CAN communi-
cation cables, all the modules are turned on, and the HP 1100 Control Module is connected. Push the <ESC> key on the Control Mod-
ule until System is displayed in the upper left corner of the display, then push the <F4> key to access the Records and display the 
firmware version.

**Only works with version B of the control module.

Module Model Number Firmware Version*

Isocratic pump G1310A 4.06

Binary pump G1312A 3.32, 3.60, 3.80, 4.06

Quaternary pump G1311A 3.32, 3.60, 4.06

Capillary pump G1376A A.04.08

Autosampler G1313A 3.30, 3.61, 3.80, 4.06

Micro-sampler G1387A A.04.06

Well-plate autosampler G1367A 4.14

Thermostatted column compartment G1316A 3.30, 3.60, 4.06, A.04.06

Variable wavelength detector G1314A 2.32, 3.60, 3.80, 4.06

Diode-array detector G1315A 3.30, 3.61, 4.06

Multiple wavelength detector** G1365B 4.08

Control module G1323A/G1323B 1.36, 2.02, B.02.02
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Table 6-9 lists the GPIB default addresses for the HP 1100 Series modules.

Table 6-9. GPIB default addresses for HP 1100 Series modules

*In the binary address, 0 means the pin is down and 1 means that the pin is up. The binary default 
address preset by HP has the number 3 pin (third pin from the left) in the 0-position for all HP 1100 
Series modules. Xcalibur data system control of the HP 1100 Series modules requires the number 3 
pin to be in the 1-position (up). The number 3 pin in the 1-position indicates the HP 1100 Series 
modules are connected with GPIB cables in daisy-chain style.

To connect the TSQ Quantum Ultra to an HP 1100 Series LC, proceed as 
follows:

1. Interconnect the modules of your HP 1100 Series LC with the CAN 
cables following the instructions in the HP 1100 Series LC reference 
manuals. The GPIB cables must be connected in daisy-chain style for 
Xcalibur to control the HP 1100 Series LC system. See Figure 6-7.

2. Verify that the correct firmware is installed in the HP 1100 Series 
modules. (Refer to Table 6-8.)

3. If your data system computer is not equipped with a PCI-GPIB PCB 
(P/N 00012-27710), you need to install the PCB and load the GPIB 
diagnostic software. For instructions on how to install and configure the 

Module Address Binary Address*

Pump 22 00110110

Autosampler 28 00111100

Column compartment 27 00111011

Variable wavelength detector 24 00111000

Diode-array detector 26 00111010

Multiple wavelength detector 26 00111010

Figure 6-7. Daisy-chain interconnection of HP 1100 Series modules with CAN 
and GPIB cables

HP Module GPIB Cable CAN CableTo Computer
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PCI-GPIB PCB refer to the topic “Installing and Configuring the 
PCI-GPIB Hardware” starting on page 6-16.

For additional information about PCI-GPIB PCB, refer to the manual 
that came with the PCB.

4. If your HP 1100 Series Autosampler is not equipped with an External 
Contact Interface PCB (P/N 00012-27714), you need to install the 
PCB, as follows:

a. Turn off the autosampler.

b. Remove the cover plate from the slot where you will install the 
External Contact Interface PCB by loosening the two screws that 
fasten the plate to the chassis of the autosampler.

c. Insert the External Contact Interface PCB into the slot and tighten 
the two screws to fasten the PCB to the chassis of the autosampler. 
See Figure 6-8.

d. Turn on the autosampler.

5. Locate the 8-bit configuration switch (labeled CONFIG) next to the 
GPIB connector on the rear of the HP 1100 Series Autosampler. Verify 
that the binary address corresponds to the binary address listed in 
Table 6-9. Repeat this step for all other HP 1100 Series modules in your 
LC system. (Figure 6-8)

6. Connect the GPIB cable (P/N 8120-3446) from the GPIB connector 
(labeled HP-IB) located on the rear of the HP 1100 Series Autosampler 
to the GPIB connector located on the rear of the data system computer. 
(Figure 6-8)
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Connecting an HP Series LC
Connecting the TSQ Quantum Ultra to an HP 1100 Series LC
7. Connect the 2-wire DB15 trigger cable (P/N 00012-27716) from the 
TSQ Quantum Ultra power entry module to the RELAY CONTACTS 
connector located on the External Contact Interface PCB of the HP 
1100 Series Autosampler following the wiring scheme shown in 
Table 6-10. 

Table 6-10. Wiring the TSQ Quantum Ultra and the HP 1100 Series Autosampler 
for contact closure

8. Use the Xcalibur data system Instrument Configuration dialog box to 
assign contact closure control to the HP 1100 Series Autosampler, as 
follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the HP1100 AS button. The HP1100 AS button is copied to the 

Figure 6-8. HP 1100 Series Autosampler rear panel

Cable Wire HP 1100 Series Autosampler 
Contact Closure Pin

TSQ Quantum Ultra 
power entry module

White 1 Start in (upper pin 8)

Brown 2 Ground (lower pin 7)

External Contact
Interface PCB

RELAY CONTACT

  

REMOTE RS232 CAN CAN HP-IB CONFIG

CAN Connectors GBIP Connector 8-Bit Configuration 
Switch
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Connecting the TSQ Quantum Ultra to an HP 1100 Series LC
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the HP1100 AS button in the Configured Devices 
group box. Xcalibur opens the HP1100 Autosampler Configuration 
dialog box.

d. Click on the Communication tab to open the Communication 
page. See Figure 6-9.

e. Leave the Board spin box set to 1.

f. Confirm that the GPIB address in the Address spin box is the same 
as that listed for the HP Series Autosampler in GPIB default 
addresses for HP 1100 Series modules. 

g. Select the Contact Board Installed check box, then click on OK to 
save the settings and close the dialog box.

9. Use the Xcalibur data system Instrument Setup to select the HP 1100 
Series Autosampler contact closure terminal and trigger type, as follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Home Page. Then, click on the Instrument Setup button to open 
the Instrument Setup window.

b. Click on the HP1100 AS button in the Instrument Setup viewbar to 
open the Instrument Setup view. Then, click on the Timed Events 
tab to open the Timed Events page. See Figure 6-10.
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Connecting an HP Series LC
Connecting the TSQ Quantum Ultra to an HP 1100 Series LC
c. Click on the Settings text box to activate the Settings list box. Then, 
select Contact 2 in the list box.

d. Click on the Value text box to activate the Value list box. Then, 
select Closed in the list box.

e. Select File > Exit to close the Instrument Setup window. Xcalibur 
prompts you with the Save As dialog box, the File Summary 
Information Dialog box, and the File Save – Audit Trail dialog box.

Figure 6-9. HP Autosampler dialog box

Figure 6-10. Instrument Setup window, showing the HP1100 Series Autosampler view with a 
portion of the Timed Events page displayed. The Timed Events page is for selecting the 
HP 1100 Series Autosampler contact closure terminal and contact closure trigger type.
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Installing and Configuring the PCI-GPIB Hardware
Installing and
Configuring the

PCI-GPIB Hardware

To install and to configure the PCI-GPIB hardware, you need to do the 
following:

• Install the PCI-GPIB driver for Microsoft Windows®

• Install the PCI-GPIB PCB in the computer

• Configure the GPIB hardware

Installing the PCI-GBIB
Driver for Microsoft

Windows

The PCI-GPIB driver is a special type of software that acts as an interface 
between your GPIB programs and the PCI-GPIB board itself. The 
Windows driver software for the PCI-GPIB is NI-488.2™ (version 1.6 or 
higher). Install the PCI-GPIB as follows:

1. Log onto your Windows system using the Administrator account.

2. Insert the CD NI-488.2 for Windows. The setup wizard will guide you 
through the necessary steps to install the GPIB software.

Installing the PCI-GPIB
PCB

Install the PCI-GPIB PCB in the data system computer as follows:

1. Turn off the data system computer.

2. Remove the computer cover to expose the PCBs.

3. Remove the cover plate from the computer PCI slot where you will 
install the PCI-GPIB PCB.

4. Carefully remove the PCI-GPIB PCB from its protective shipping bag. 
Wear a grounding strap to avoid damaging the PCI-GPIB PCB.

5. Hold the PCI-GPIB PCB by its edges and position it so that the GPIB 
connector faces the rear of the computer.

6. Plug the PC-GPIB PCB into the slot of the computer by firmly pushing 
the edge of the PCB into the connector until the PCB is seated.

Note You must load the proper NI-488.2 driver for your PCI-GPIB 
board before you install the board in your computer. If you install the 
board before loading the driver, Windows will not properly register your 
board. 

Caution Wear a grounding strap to avoid damaging the PCI-GPIB 
PCB. 
6-16 Finnigan TSQ Quantum Ultra Getting Connected Thermo Electron Corporation



Connecting an HP Series LC
Installing and Configuring the PCI-GPIB Hardware
7. Use the screw from the slot cover plate to secure the PCI-GPIB PCB in 
place.

8. Replace the computer cover.

9. Restart the data system computer. The plug and play PCI-GPIB board 
should be recognized immediately by Windows, which will display a 
"New Hardware Found" message.

10. The NI-488.2 Getting Started Wizard should launch. If it does not, 
choose Start > Programs > National Instruments 488.2 > 
Getting Started Wizard. 

11. In the NI-488.2 Getting Started Wizard, click on Verify your 
hardware and software installation. This starts the NI-488.2 
Troubleshooting Wizard, which will confirm that your driver software 
and GPIB hardware are properly installed. 

12. When the NI-488.2 Troubleshooting Wizard finishes, click on Exit to 
return to the NI-488.2 Getting Started Wizard.

13. If you want to see information on how to use the NI-488.2 software, 
click on Communicate with your instrument in the NI-488.2 
Getting Started Wizard. You will be led through a six-step procedure on 
how to find GPIB instruments with the Measurement and Automation 
Explorer and how to communicate with them using the NI-488.2 
Communicator.

14. Click on Exit to leave the NI-488.2 Getting Started Wizard. Your 
PCI-GPIB board is properly installed.

Configuring the GPIB
Hardware

Configure the GPIB hardware as follows:

1. Choose Start > Settings > Control Panel to open the Control 
Panel dialog box, then double-click on the GPIB icon to open the GPIB 
Configuration dialog box. The GPIB Configuration utility displays a 
list of all the available GPIB boards and device names. See Figure 6-11.
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Getting Connected 6-17



Connecting an HP Series LC
Installing and Configuring the PCI-GPIB Hardware
2. In the GPIB Configuration dialog box, select GPIB0 from the GPIB 
Board list.

3. Click on Board Type to open the Board Type dialog box, then select 
PCI-GPIB. Click on OK to save the settings and close the Board Type 
dialog box. 

4. Configure the GPIB software for the PCI-GPIB interface, as follows:

a. Click on Configure in the GPIB Configuration dialog box to 
open the GPIB0 Configuration dialog box. See Figure 6-12.

b. The serial number of the board should appear in the Serial Number 
or Slot Number box. Click on OK to close the dialog box. 

c. In the GPIB Configuration dialog box, click on OK to save the 
changes and exit the utility. The Restart GPIB Software? dialog box 
appears.

d. In the Restart the GPIB Software dialog box, click on Yes to close 
the dialog box and restart the data system computer.

Figure 6-11. GPIB Configuration dialog box

Figure 6-12. GPIB0 dialog box
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Chapter 7 Connecting the Agilent 1100 
Series LC

The Xcalibur data system allows control of the Agilent® 1100 Series LC. 

For additional information about the Agilent 1100 Series LC refer to the 
Agilent 1100 Series LC reference manuals.

Table 7-1 lists the Xcalibur supported firmware versions for the 
Agilent 1100 Series LC.

Table 7-1. Xcalibur supported firmware versions for the Agilent 1100 Series LC

*To obtain the firmware versions for the Agilent 1100 modules, verify that the Agilent 1100 Series modules are connected by CAN 
communication cables, all the modules are turned on, and the Agilent 1100 Control Module is connected. Push the <ESC> key on the 
Control Module until System is displayed in the upper left corner of the display, and then push the <F4> key to access the Records 
and display the firmware version.

**Only works with version B of the control module.

Module Model Number Firmware Version*

Isocratic pump G1310A 4.06

Binary pump G1312A 3.32, 3.60, 3.80, 4.06

Quaternary pump G1311A 3.32, 3.60, 4.06

Capillary pump G1376A A.04.08

Autosampler G1313A 3.30, 3.61, 3.80, 4.06

Micro-sampler G1387A A.04.06

Well-plate autosampler G1367A 4.14

Thermostatted column compartment G1316A 3.30, 3.60, 4.06, A.04.06

Variable wavelength detector G1314A 2.32, 3.60, 3.80, 4.06

Diode-array detector G1315A 3.30, 3.61, 4.06

Multiple wavelength detector** G1365B 4.08

Control module G1323A/G1323B 1.36, 2.02, B.02.02
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Connect the TSQ Quantum Ultra to an Agilent 1100 Series LC as follows:

1. Interconnect the modules of your Agilent 1100 Series LC with the CAN 
cables following the instructions in the Agilent 1100 Series LC reference 
manuals.

2. Locate the 8-bit configuration switch (labeled CONFIG) on the rear of 
each Agilent 1100 Series module. Make sure that the third DIP switch is 
in the 0 position (down) to specify the use of the Ethernet interface. 

3. If your Agilent 1100 Series Autosampler is not equipped with an 
External Contact Interface PCB (P/N 00012-27714), you need to 
install the PCB:

a. Make sure that the autosampler is Off.

b. Remove the cover plate from the slot where you will install the 
External Contact Interface PCB by loosening the two screws that 
fasten the plate to the chassis of the autosampler.

c. Insert the External Contact Interface PCB into the slot and tighten 
the two screws to fasten the PCB to the chassis of the autosampler. 
See Figure 7-1.

4. Connect the 2-wire DB15 trigger cable (PCB P/N 00012-27716) from 
the TSQ Quantum Ultra I/O panel to the RELAY CONTACT 
connector located on the External Contact Interface PCB of the Agilent 
1100 Series Autosampler following the wiring scheme shown in 
Table 7-2. 

Note The Agilent 1100 Series devices query the PC for the stack IP 
address only during their start up procedure. Therefore, complete the 
following procedure and ensure that the Xcalibur Home Page window is 
open before turning on the Agilent 1100 Series devices. 
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Table 7-2. Wiring the TSQ Quantum Ultra and the Agilent 1100 series 
autosampler for contact closure

5. An HP JetDirect® 400N network card must be installed in one module 
in the Agilent 1100 Series LC stack. If your LC stack contains a detector 
(e.g., diode-array detector, variable wavelength detector, multiple 
wavelength detector), the HP JetDirect 400N network card should be 
installed in the detector. Otherwise, it can be installed in any module 
with an open slot. If you need to install the HP JetDirect 400N network 
card, do the following:

a. Make sure that the module is Off.

b. Remove the cover plate from the slot where you will install the HP 
JetDirect 400N network card by loosening the two screws that 
fasten the plate to the chassis of the module.

c. Insert the HP JetDirect 400N network card into the slot and 
tighten the two screws to fasten the PCB to the chassis of the 
module. 

6. Connect an Ethernet cable from the JetDirect 400N network card to 
the Ethernet hub.

Figure 7-1. Agilent 1100 series autosampler rear panel
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Interface PCB

RELAY CONTACT

  

REMOTE RS232 CAN CAN HP-IB CONFIG

CAN Connectors GBIP Connector 8-Bit Configuration 
Switch

Cable Wire Agilent 1100 Series Autosampler 
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Connecting the Agilent 1100 Series LC
7. Connect an Ethernet cable from the Ethernet hub to the Ethernet card 
in the computer that is dedicated to the LC system (typically Network 
Interface Card number 3).

8. Use the Xcalibur data system Instrument Configuration dialog box to 
assign contact closure control to the Agilent 1100 Series Autosampler, as 
follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the Agilent 1100 AS button. The Agilent 1100 AS button is copied 
to the Configured Devices group box and is displayed as a 
Configured Devices button.

c. Double-click on the Agilent 1100 AS button in the Configured 
Devices group box. Xcalibur opens the Agilent 1100 Autosampler 
Configuration dialog box.

d. Click on the General tab to open the General page. See Figure 7-2.

e. Select the Contact Board Installed check box.

f. In the Stack MAC address text box, enter the Media Access Control 
address for your Agilent LC stack. The stack MAC address is a 
unique identification for each network card. The manufacturer 
usually stamps it on the network card.

g. In the Stack IP Address list box, enter the IP address for your 
Agilent 1100 LC stack. Contact your network administrator for the 
IP address.

h. In the Sub-mask text box, enter the subnet mask (address mask). 
Leave the subnet mask set to its default value, or contact your 
network administrator for the subnet mask.

i. In the Bootp Server text box, enter the IP address for the network 
card in your PC that is responsible for assigning the stack IP address 
for your Agilent 1100 LC system. Contact your network 
administrator for the BOOTP server IP address.

j. Click on OK to save the settings and close the dialog box.

Note The TCP/IP settings are shared by all Agilent 1100 LC modules in 
the stack. Changing the value of a setting for one module in the 
Instrument Configuration dialog box changes the value of that setting 
for all modules in the stack. 
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9. Use the Xcalibur data system Instrument Setup to select the Agilent 
1100 Series Autosampler contact closure terminal and trigger type, as 
follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Home Page. Then, click on the Instrument Setup button to open 
the Instrument Setup window.

b. Click on the Agilent 1100 AS button in the Instrument Setup 
viewbar on the left side of the window to open the Instrument 
Setup view. Then, click on the Timed Events tab to open the Timed 
Events page. See Figure 7-3.

c. Click on the Settings text box to activate the Settings list box. Then, 
select Contact 2 in the list box.

d. Click on the Value text box to activate the Value list box. Then, 
select Closed in the list box.

e. Select File > Exit to close the Instrument Setup window. Xcalibur 
prompts you with the Save As dialog box, the File Summary 
Information Dialog box, and the File Save – Audit Trail dialog box.

10. Ensure that the Xcalibur Home Page is still open and power up the 
Agilent 1100 Series modules. 

11. Verify that the correct firmware is installed in the Agilent 1100 Series 
modules. (Refer to Xcalibur supported firmware versions for the Agilent 
1100 Series LC.) 

Figure 7-2. Agilent Autosampler dialog box
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Figure 7-3. Instrument Setup window, showing the Agilent 1100 series autosampler 
view with a portion of the Timed Events page displayed. The Timed Events 
page is for selecting the Agilent 1100 Series Autosampler contact closure 
terminal and contact closure trigger type.
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Chapter 8 Connecting the Waters LC

The Xcalibur data system allows control of the Waters Alliance® 2690 
Separations Module.

The following topics are discussed in this chapter:

• Connecting the TSQ Quantum Ultra to a Waters Alliance 2690 
Separations Module

• Connecting the TSQ Quantum Ultra to the Waters 2487 Dual l 
Absorbance Detector

Table 8-1 lists the contents of the Xcalibur kits used with the Waters LC.

Table 8-1. Xcalibur kits used with the Waters LC

Part Number Description of Kit

OPTON-21710 Xcalibur Waters Interface Kit
Waters serial I/F cable
2-wire trigger cable (contact closure)

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x PCB 
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit
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Connecting the TSQ Quantum Ultra to the Waters Alliance 2690 Separations Module
Connecting the TSQ
Quantum Ultra to the

Waters Alliance 2690
Separations Module

Table 8-2 lists the Xcalibur supported firmware version for the Waters 
Alliance 2690 Separations Module.

Table 8-2. Xcalibur supported firmware version for the Waters Alliance 2690 
Separations Module

*To obtain the firmware version for the Waters Alliance 2690 Separations Module, turn on the instru-
ment and watch the front panel display as the instrument cycles through the system startup.

For additional information about the Waters Alliance 2690 Separations 
Module refer to the Waters 2690 Separations Module Operator’s Guide.

To connect the TSQ Quantum Ultra to a Waters Alliance 2690 Separations 
Module, proceed as follows.  See Figure 8-1.

1. Connect the serial cable (P/N 00012-51086) from the RS-232 
connector (labeled B) located on the rear of the Waters Alliance 2690 
Separations Module to an available RS-232 connector located on the 
rear of the data system computer. 

2. Connect the 2-wire trigger cable (in kit P/N OPTON-21710) from the 
TSQ Quantum Ultra power entry module to the contact closure 
terminal (labeled B) located on the rear of the Waters Alliance 2690 
Separations Module following the wiring scheme shown in Table 8-3.

Module Model Number Firmware Version*

Separations module 2690 1.2

Figure 8-1. Waters Alliance 2690 Separations Module rear panel contact 
closure terminals

Pin 1
Pin 2

Contact Closure 
Terminal B

B A

RS232
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Connecting the TSQ Quantum Ultra to the Waters Alliance 2690 Separations Module
Table 8-3. Wiring the TSQ Quantum Ultra and the Waters Alliance 2690 Separations 
Module for contact closure

3. Set the Waters 2690 Separations Module RS-232 communication to 
ASCII as follows:

a. From the Main page on the instrument display, press the <Config> 
key to open the Configuration page.

b. Use the < > key to select the Controlled via RS-232 option in the 
System group box.  Then press the <Enter> key to open the list box.

c. Use the < _ > and < _ > keys to select Controlled by RS-232 
(ASCII) in the list box.  Then press the <Enter> key to save the 
change.

d. Press the <Exit> key to return to the Main page.

4. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from Waters Alliance 2690 Separations 
Module to an available port, such as COM1 (port A), of the data system 
computer, as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the Waters 2690 button.  The Waters 2690 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

c. Double-click on the Waters 2690 button in the Configured Devices 
group box.  Xcalibur opens the Alliance 2690 Configuration dialog 
box.  See Figure 8-2.

d. Confirm that the Port list box in the RS-232 Configuration group 
box is set to COM1.

e. Click on Autoconfigure, then click on OK to save the settings 
and close the dialog box.

Waters Alliance 2690 Separations Module
Contact Closure Terminal B

TSQ Quantum Ultra Power Entry Module

Pin 1 Start In +

Pin 2 Ground
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Connecting the TSQ Quantum Ultra to the Waters Alliance 2690 Separations Module
Figure 8-2. Alliance 2690 Configuration dialog box
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Connecting the TSQ Quantum Ultra to the Waters 2487 Dual Wavelength Absorbance Detector
Connecting the TSQ
Quantum Ultra to the

Waters 2487 Dual
Wavelength

Absorbance Detector

If your Waters LC system is equipped with a Waters 2487 Dual λ 
Absorbance Detector and you want to record analog output from the 
detector, you need to connect the SS420X to the data system computer.

For instructions on how to install and configure the SS420X refer to 
Chapter 10: “Connecting the SS420x Analog-to-Digital Interface Kit”.

Connect the Waters 2487 Dual λ Absorbance Detector to the SS420X, as 
follows:  Connect the 2-wire signal cable (in kit P/N OPTON-21710) from 
the terminal (labeled B) located on the rear of the Waters 2487 Dual λ 
Absorbance Detector to the bus terminal located on the SS420X terminal 
panel interface.  Follow the wiring scheme shown in Table 8-4.

Table 8-4. Wiring connection for the Waters 2487 Dual λ Absorbance Detector 
and the SS420X terminal panel

Waters 2487 Dual λ Absorbance Detector
Terminal B

SS420X Terminal Panel
(use any channel 1 to 4)

Pin 1 CH +

Pin 3 CH -

Note  Confirm that the Waters 2487 Dual l Absorbance Detector is 
connected to the Waters 2690 Separations Module with the GPIB cable 
that was supplied with your LC system.  Turn on the detector before you 
turn on the Waters 2690 Separations Module. 
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Chapter 9 Connecting the Gilson 215 
Liquid Handler

The Xcalibur data system allows control of the Gilson NEBULA Series™ 
215 Liquid Handler.

Table 9-1 lists the contents of the Xcalibur kit used with the Gilson 215 
Liquid Handler.

For additional information about the Gilson 215 Liquid Handler, refer to 
the Gilson 215 Liquid Handler User’s Guide. 

Table 9-2 lists the Xcalibur supported firmware versions for the Gilson 215 
Liquid Handler and 819 Valve Actuator.

*To obtain the firmware version for the Gilson 215 Liquid Handler, turn on the instrument and watch 
the front panel display as the instrument cycles through the system startup.

To connect the TSQ Quantum Ultra to a Gilson 215 Liquid Handler, 
proceed as follows:

1. Connect the serial cable and attached null modem adapter (in kit P/N 
OPTON-21707) to the RS-232 connector located on the rear of the 
Gilson 215 Liquid Handler. Connect the other end of the cable to the 
RS-232 connector (labeled A) located on the rear of the data system 
computer.

Table 9-1. Xcalibur Kit used with the Gilson 215 Liquid Handler

Part Number Description of Kit

OPTON-21707 Xcalibur Gilson Interface Kit
serial cable
2-wire trigger cable (contact closure)

Table 9-2. Xcalibur supported firmware versions for the Gilson 215 Liquid 
Handler and Valve Actuator

Module Model Number Firmware Version*

Liquid Handler 215 1.21

Valve Actuator 819 2.0
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Connecting the Gilson 215 Liquid Handler
2. Connect the 2-wire trigger cable (in kit P/N OPTON-21707) from the 
TSQ Quantum Ultra power entry module to the contact closure 
terminal (labeled Output) located on the rear of the Gilson 215 Liquid 
Handler. Choose any pair of pins (labeled 1 to 4). The top pin of the 
pair is positive (+), the lower pin is ground. Follow the wiring scheme 
shown in Table 9-3. See Figure 9-1.

3. Use the Xcalibur data system Instrument Configuration dialog box to 
assign the RS-232 connection from the Gilson 215 Liquid Handler to 
an available port such as COM1 (port A) of the data system computer, 
as follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the Gilson 215 button. The Gilson 215 button is copied to the 
Configured Devices group box and is displayed as a Configured 
Devices button.

Table 9-3. Wiring the TSQ Quantum Ultra and the Gilson 215 Liquid Handler for 
contact closure

Gilson 215 Liquid Handler Contact 
Closure Terminal 

(use any pair of pins 1 through 4)
TSQ Quantum Ultra Power

Entry Module

Top Pin Start In (upper pin 8)

Bottom Pin Ground (lower pin 7)

Figure 9-1. Gilson 215 Liquid Handler rear panel OUTPUT contact closure 
terminal

Top Pin
Bottom Pin

Output
+ 24 V dc

(1 Amp Max)
GND

1

2

3

4
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Connecting the Gilson 215 Liquid Handler
c. Double-click on the Gilson 215 button in the Configured Devices 
group box. Xcalibur opens the Gilson 215 Configuration dialog 
box. See Figure 9-2.

d. Click on the Communication tab to open the Communication 
page. 

e. Confirm that the port in the Communication Port list box is set to 
COM1. 

f. Click on OK to save the settings and close the dialog box.

Figure 9-2. Gilson 215 Configuration dialog box with the Communication page 
displayed
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Chapter 10  Connecting the SS420x 
Analog-to-Digital Interface Kit

The Scientific Software Inc. (SSI) SS420x offers four independent (20-bit 
resolution) analog-to-digital (A/D) converters for data acquisition from 
devices that are not currently controlled by Xcalibur. Additionally, there are 
four inputs and eight outputs that provide contact closure control for 
devices that are not currently controlled by Xcalibur. For this chapter, 
contact closure refers to open collector, TTL logic, or relay closure.

Xcalibur can support up to four SS420x units; however, only one unit can 
be used at a time.

The following topics are discussed in this chapter:

• Connecting and Configuring the SS420x

• Configuring the SS420x for Data Acquisition and Control of External 
Devices

Table 10-1 lists the contents of the Xcalibur kit used with the SS420x.

Table 10-1. Xcalibur Kit used with the SS420x

Part Number Description of Kit

OPTON-21721 Xcalibur SS420x Interface Kit
SS420x
serial cable
2-wire trigger cable (contact closure) 
power supply
Xcalibur Additional 4-Port Serial Kit
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Connecting and Configuring the SS420x
Connecting and
Configuring the

SS420x

Connect the SS420x to the data system computer and configure it for the 
Xcalibur data system, as follows:

1. Turn off the data system computer.

2. Connect the serial cable to the RS-232 port on the rear of the SS420x. 

3. Connect the other end of the serial cable to the RS-232 port located on 
the rear of the data system computer. Be sure to use only ports 1 
through 4 to connect the SS420x.

4. Connect the power cable from the 9 V dc power supply included with 
the SS420x to the POWER inlet located on the rear of the SS420x. 

5. Verify that the SS420x is configured for Xcalibur data system control as 
follows:

a. Choose Start > Programs > Xcalibur > Instrument 
Configuration to open the Instrument Configuration dialog box.

b. Scroll through the Available Devices group box and double-click on 
the SSI SS420x A/D Converter button. The SSI SS420x A/D 
Converter button is copied to the Configured Devices group box 
and is displayed as a Configured Devices button.

c. Double-click on the SSI SS420x A/D Converter button in the 
Configured Devices group box. Xcalibur opens the SS420x 
Configuration dialog box.

d. Select the COM port to which the device is attached. 

e. Click on OK to save the changes and close the SS420X 
Configuration dialog box.

f. Click on Done to close the Instrument Configuration dialog box.
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Configuring the SS420x for Data Acquisition and Control of External Events
Configuring the
SS420x for Data
Acquisition and

Control of
External Events

The SS420x has two functions as described in the following topics: 

• Data Acquisition from Analog Devices

• Control of External Events

Data Acquisition from
Analog Devices

The SS420x has four channels on the analog-to-digital converter (Channel 
A to Channel D) that allow for data input from analog devices not currently 
controlled by Xcalibur.

To acquire data from an analog device, the following connections are 
required: 

• A 2-wire signal cable from each analog device to the SS420x 

• A 2-wire trigger cable from the analog device(s) to the LC autosampler

• A 2-wire trigger cable (contact closure) from the LC autosampler to the 
SS420x

• A 2-wire trigger cable (contact closure) from the LC autosampler to the 
TSQ Quantum Ultra

Connect the cables and configure the SS420x, as follows. See Figure 10-1.

1. Connect the 2-wire signal cable from the SS420x to the analog device. 
Follow the wiring scheme shown in Table 10-2. If you want to connect 
more than one analog device to the SS420x, use a separate channel 
(Channel A to Channel D) for each device.

Table 10-2. Wiring an analog device and the SS420x for A/D data acquisition

Note The following procedure is a general procedure for connecting up 
to four analog devices to the SS420x. Your particular application might 
require a different procedure or a different configuration of devices. 

SS420x
Analog Inputs

Analog Device
(0 to 1 V or 0 to 10 V Output)

CH1 + Signal output pin

CH1 - Ground pin
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
2. Connect a 2-wire trigger cable from the analog device to the LC 
autosampler. Follow the wiring scheme shown in Table 10-3.

Table 10-3. Wiring the LC autosampler and the analog device for contact closure

Note Figure 10-1 shows how to connect the maximum of four analog 
devices to the SS420x. Your particular application might require a 
different configuration of devices or a different wiring scheme. 

Figure 10-1. Wiring diagram showing four analog devices connected to the SS420x and autosampler. Each 
analog device is connected with a 2-wire signal cable and 2-wire trigger cable (contact closure). 

2-Wire Signal Cable

2-Wire Trigger Cable

Computer

Autosampler

Analog Device 

1

Analog Device 

2

Analog Device 

3

Analog Device 

4

SS420x

TSQ Quantum 

Discovery

Thinwire Ethernet Cable

2-Wire Trigger Cables

2-Wire  

Signal Cables

Analog Device LC Autosampler

Start in pin Inject out pin

Ground pin Ground pin
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
3. Connect a 2-wire trigger cable from the LC autosampler to the SS420x. 
Follow the wiring scheme shown in Table 10-4.

Table 10-4. Wiring the LC autosampler and the SS420x for contact closure 

4. Connect a 2-wire trigger cable from the LC autosampler to the 
TSQ Quantum Ultra. Follow the wiring scheme shown in Table 10-5.

Table 10-5. Wiring the LC autosampler and the TSQ Quantum Ultra for contact 
closure 

5. Configure the SS420x for data acquisition, as follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Xcalibur data system Home Page. Then, click on the Instrument 
Setup button to open the Instrument Setup window.

b. Click on the SSI SS420x A/D Converter button to open the SS420x 
Instrument Setup view with the Acquisition page displayed. 
See Figure 10-2.

LC Autosampler SS420x 
(START1 to START4)

Inject out pin START1 + 

Ground pin GND1 − 

LC Autosampler TSQ Quantum Ultra 
Inputs

Inject out pin Start in +

Ground pin ground
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
c. Select 1 in the Number of Channels In Use spin box. (If more than 
one channel is to be used, select the appropriate number of 
channels.)

d. Select the data acquisition rate in the Frequency list box.

e. In the Channel A text box enter the name of the analog device. (If 
more than one channel is to be used, enter the name of each device 
in the appropriate channel text box.)

f. The acquisition of data through the SS420x can be stopped by 
either an Xcalibur-controlled device or after a specified time, as 
follows: 

• In the Acquisition Time group box, select the Run Until The 
Device Ends option button if you want a device to stop the 
SS420x data acquisition. In the Run Until The Device Ends list 
box, select the device that will signal the stop of data acquisition.

or

Figure 10-2. Instrument Setup window, showing the SS420x view with the Acquisition page 
displayed 
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
• In the Acquisition Time group box, select the Specify Time 
option button if you want the SS420x to stop data acquisition 
after a specified time. In the Specify Time spin box, enter the 
acquisition time.

6. Click on the Configuration tab to open the Configuration page. See 
Figure 10-3. Then, setup the SS420x as follows: 

a. Confirm that the appropriate Channel (Channel A to Channel D) 
Range is selected from the range list box, as follows:

• 0 - 1 V, if the output signal from the analog device is between 
-1 and +1 V

• 0 - 10 V, if the output signal from the analog device is between 
-10 and +10 V

b. Select Trig 1 in the Trigger Line list box. If you want to use a device 
other than the LC autosampler to start data acquisition, select the 
appropriate trigger line that is connected to the device.

c. Select Closed Contact in the Trigger Type list box or refer to the 
analog device reference manual to determine the trigger type setting.

Note The analog device can be triggered by either a closed contact or 
open contact signal. Refer to the reference manual that is supplied with 
your device to determine its trigger type. 
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
Figure 10-3. Instrument Setup window, showing the SS420x view with the 
Configuration page displayed 

Note  In the Configuration dialog box, the values that appear in the 
Calibration group box are set by the manufacturer to ensure proper 
performance of the A/D converter. 

Note After you have set up your sequence and loaded the autosampler 
with your samples, open the Run Sequence dialog box and verify that no 
instrument is selected as a Start Instrument. Start the run and watch the 
Home Page - Status View (choose View > Status View) until both the 
SS420x and TSQ Quantum Ultra display Wait for Contact Closure. 
Then, manually start the autosampler. 
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
Control of External Events The SS420x has eight digital outputs (labeled RLY1 to RLY8) that can be 
used to control devices that are not currently controlled by Xcalibur. 

To connect an external device to the SS420x and to configure the SS420x, 
proceed as follows:

1. Connect a 2-wire trigger cable from input terminals of the external 
device to the SS420x. Follow the wiring scheme shown in Table 10-6.

Table 10-6. Wiring an external device and the SS420x for contact closure

2. Configure the SS420x to control an external device, as follows:

a. Choose Start > Programs > Xcalibur > Xcalibur to open the 
Xcalibur data system Home Page. Then, click on the Instrument 
Setup button to open the Instrument Setup window.

b. Click on the SSI SS420x A/D Converter button to open the SS420x 
view with the Acquisition page displayed. See Figure 10-2. Then, 
click on the External Events tab to open the External Events page. 
See Figure 10-4.

Note External devices can be triggered by either a closed contact or open 
contact signal. Refer to the reference manual that is supplied with your 
external device to determine its trigger type. 

External Device
SS420x

(RLY1 to RLY8)

Input pin RLY A 

Ground pin RLY B
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Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
c. In the Events Description group box select the number of events 
you want to control in the Number of Events spin box. You can 
control up to 50 events.

d. In the Description text box, enter a description of the multi-event 
procedure you want to run.

e. Set up an event in the Event Setup group box, as follows:

i. In the Event 1 row, enter a description of the first event in the 
Descriptions text box.

ii. Enter a delay time for the event in the Delay Time text box. The 
delay time determines when an event occurs. The delay time 
equals zero when the SS420x starts acquisition or the 
TSQ Quantum Ultra sends a contact closure signal.

iii. Select the digital output terminal that you want to trigger, as 
follows: 

Figure 10-4. Instrument Setup window, showing the SS420x view with the 
External Events page displayed. In this example the SS420x 
controls three devices. The three devices are Trigger Type - Closed 
Contact
10-10 Finnigan TSQ Quantum Ultra Getting Connected Thermo Electron Corporation



Connecting the SS420x Analog-to-Digital Interface Kit
Configuring the SS420x for Data Acquisition and Control of External Events
• For a Trigger Type - Closed Contact device:
When the Digital Output In Use check box is selected, the 
external device receives a closed contact signal at the specified 
delay time. When the Digital Output In Use check box is not 
selected, the external device receives an open contact signal at 
the specified delay time.

or

• For a Trigger Type - Open Contact device:
When the Digital Output In Use check box is selected, the 
external device receives an open contact signal at the specified 
delay time. When the Digital Output In Use check box is not 
selected, the external device receives a closed contact signal at 
the specified delay time.

iv. Repeat steps i-iii for the next event.

Figure 10-4 shows an example of the SS420x controlling three external 
devices with five events over a period of 4 hours (14400 seconds). For this 
example all devices are Trigger Type - Closed Contact. When a closed 
contact event occurs, the external device turns on and performs its function. 
When the open contact event occurs, the external device turns off and 
ceases its function. 
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Chapter 11 Connecting the 4-Port Serial 
PCB 

The 4-Port Serial PCB and Quad DB9 male cable (P/N OPTON-21709) 
provide four additional communication ports for the data system computer. 
See Figure 11-1.

Table 11-1 lists the contents of the Xcalibur kit used with the 4-Port Serial 
PCB.

Table 11-1. Xcalibur Kit used with the 4-Port Serial PCB

Part Number Description of Kit

OPTON-21709 Xcalibur Additional 4-Port Serial Kit
4-Port Serial PCB (PCI) and software
Quad DB (male adapter)

Figure 11-1. 4-Port Serial PCB and Quad DB9 male cable

4-Port Serial PCB

Quad DB9 Male Cable
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Connecting the 4-Port Serial PCB
To install the 4-Port Serial PCB in the data system computer, proceed as 
follows:

1. Turn off the data system computer.

2. Remove the computer cover to expose the PCBs.

3. Remove the cover plate from the computer slot where you want to 
install the 4-Port Serial PCB.

4. Carefully remove the 4-Port Serial PCB from its protective shipping bag. 
Wear a grounding strap to avoid damaging the 4-Port Serial PCB.

5. Hold the 4-Port Serial PCB by its edges and position it so that the 
78-pin connector faces the rear of the computer.

6. Plug the 4-Port Serial PCB into the slot of the computer by firmly 
pushing the edge of the card into the connector until the card is seated.

7. Use the screw from the slot cover plate to secure the 4-Port Serial PCB 
in place.

8. Replace the computer cover.

9. Connect the Quad DB9 male cable to the connector located on the 
4-Port Serial PCB. Connect the other end of the cable to the appropriate 
inlet device.

10. Restart the data system computer.

The 4-Port Serial PCB is a Plug and Play device. When Windows starts, it 
automatically detects and configures the new 4-Port Serial PCB and then 
loads the appropriate drivers.

Caution Wear a grounding strap to avoid damaging the 4-Port Serial 
PCB. 
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Chapter 12 Making Plumbing 
Connections to Run Samples on the 
TSQ Quantum Ultra

This chapter describes how to make plumbing connections to run samples 
on the TSQ Quantum Ultra.

The following topics are discussed in this chapter:

• Plumbing connections for H-ESI/MS

• Plumbing connections for APCI/MS

Table 12-1 summarizes the sample introduction and analytical techniques 
for H-ESI/MS and APCI/MS.

Table 12-2 lists the frequently used parts for making plumbing connections 
for H-ESI/MS and APCI/MS.

Table 12-1. Sample introduction and analytical techniques for H-ESI/MS and APCI/MS

Sample Introduction to 
TSQ Quantum Ultra Mass Spectrometer

H-ESI Analytical Technique APCI Analytical Technique

Syringe pump

H-ESI/MS (Figure 12-1, page 12-6)

Analysis of a pure analyte 

Automatic calibration and tuning

Syringe pump injection into LC solvent flow

H-ESI/MS (Figure 12-2, page 12-7) 

APCI/MS (Figure 12-6, page 12-12)

Analysis of a pure analyte Analysis of a pure analyte

Loop injection into LC solvent flow

H-ESI/MS (Figure 12-3, page 12-8)

H-ESI/MS (Figure 12-5, page 12-10)

APCI/MS (Figure 12-7, page 12-13)

Analysis of a pure analyte 

Automatic optimization of tuning 
using an analyte

Analysis of a pure analyte 

Automatic optimization of tuning using 
an analyte

Autosampler without chromatographic 
separation

H-ESI/MS (Figure 12-4, page 12-9)

APCI/MS (Figure 12-8, page 12-14)

Analysis of one or more pure 
analytes

Analysis of one or more pure analytes

Autosampler with chromatographic separation

H-ESI/MS (Figure 12-4, page 12-9)

APCI/MS (Figure 12-8, page 12-14)

Analysis of a mixture Analysis of a mixture
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Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Table 12-2. Frequently used parts for making plumbing connections for H-ESI/MS and APCI/MS

Part Part Description Part Number

Metal Needle Kit
(contains a blunt-tip, 32-gauge stainless steel needle; ferrules; PEEK™ 
adapter union; and ZDV 1/4-28 union)

70111-62035

Metal Needle Kit
(contains a blunt-tip, 34-gauge stainless steel needle; ferrules; PEEK 
adapter union; and ZDV 1/4-28 union)

70111-62036

Tubing, fused-silica, 0.1 mm ID x 0.4 mm OD
(infusion line)

00106-10504

Tubing, fused-silica, 0.1 mm ID x 0.190 mm OD
(fused-silica sample tube and fused-silica capillary tube)

00106-10499

Tubing, PEEK, 0.005 in. ID x 1/16 in. OD (red) 00301-22912

Tube, Teflon, 0.03 in. ID x 1/16 in. OD
(for use with syringe needle and LC union)

00301-22915

Tubing, PVC, unreinforced, 3/8 in. ID (clear)
(API probe drain tube)

00301-22895

Fitting, Adapter, Kel-F, Upchurch Scientific (connects directly to H-ESI 
probe inlet)

00101-18080

Fitting, Fingertight, Upchurch Scientific (brown)
(used with (red) PEEK tubing)

00101-18081

Ferrule, Kel-F, 0.008 in. ID, Upchurch Scientific (clear)
(used with fused-silica tubing and the blunt-tip, 34-gauge stainless 
steel needle included in Metal Needle Kit)

00101-18114

Ferrule, Kel-F, 0.012 in. ID, Upchurch Scientific (clear)
(used with blunt-tip, 32-gauge stainless steel needle included in Metal 
Needle Kit)

00101-18116

Ferrule, 0.016 in. ID, PEEK, Upchurch Scientific (brown)
(for use with fused-silica infusion line)

00101-18120

Ferrule, LC, 1/16 in., stainless steel, Valco
(used to connect the (red) PEEK tubing and the sample loop to the 
divert/inject valve)

00101-18122

Fitting, grounding union, 1/16 in. orifice, stainless steel 00101-18182

Fitting, Fingertight, Upchurch Scientific (red)
(used with (red) PEEK tubing)

00101-18195

Ferrule, Fingertight 2, Upchurch Scientific (brown)
(used with the Teflon tubing and (red) PEEK tubing)

00101-18196

Fitting, LC union, 0.010 in. orifice, PEEK (black) 00101-18202
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Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Fitting, LC TEE union, 0.020 in. orifice, PEEK (black) 00101-18204

Fitting, adapter union, PEEK, Upchurch Scientific (brown)
(used with blunt-tip 32 or 34-gauge stainless steel needle, included in 
Metal Needle Kit) 

00101-18206

Nut, LC 1/16 in. stainless steel, Rheodyne 2522-0066

Ferrule, LC 1/16 in. stainless steel, Rheodyne
(used to connect the (red) PEEK tubing and the sample loop to the 
divert/inject valve)

2522-3830

5 µL sample loop, stainless steel, Rheodyne 00110-22010

10 µL sample loop, stainless steel, Rheodyne 00110-22012

20 µL sample loop, stainless steel, Rheodyne 00110-22014

50 µL sample loop, stainless steel, Rheodyne 00110-22016

100 µL sample loop, stainless steel, Rheodyne 00110-22018

500 µL sample loop, stainless steel, Rheodyne 00110-22020

1 mL sample loop, stainless steel, Rheodyne 00110-22022

Table 12-2. Frequently used parts for making plumbing connections for H-ESI/MS and APCI/MS

Part Part Description Part Number
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Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Plumbing Connections for H-ESI/MS
Plumbing
Connections for

H-ESI/MS

You can fit the H-ESI probe with either a fused-silica sample tube or an 
optional blunt-tip, 32- or 34-gauge stainless steel needle.  The 0.100 mm 
ID × 0.190 mm OD fused-silica sample tube (P/N 00106-10499) is 
supplied in the standard Accessory Kit (P/N 70111-62034).  A high flow, 
blunt-tip, 32-gauge, stainless steel needle (P/N 97055-20564) and a low 
flow, blunt-tip, 34-gauge, stainless steel needle (P/N 97055-20565) are 
supplied in an optional Metal Needle Kit (P/N OPTON-20034).

There are several operating conditions in which you might choose to use the 
stainless steel needle rather than the fused-silica sample tube.

These include the following:

• When you are analyzing compounds with polar functional groups, some 
of the compounds might show improved ionization efficiency, especially 
acidic compounds in negative ion electrospray mode.

• Operation at very low flow rates in pure electrospray mode (i.e., with 
sheath and auxiliary gases turned off ).  Using a smaller internal diameter 
needle or fused-silica capillary produces smaller droplets, which might 
improve signal and stability. Use the 32-gauge metal needle for flow 
rates from 5 µL/min to 400 µL/min, and the 34-gauge metal needle for 
flow rates from 500 nL/min to 10 µL/min.

• Operation with acetonitrile in the mobile phase.  Acetonitrile can cause 
elongation of the polyimide coating on the fused-silica capillary, which 
can degrade signal and signal stability over time.  The stainless steel 
needle is not affected by acetonitrile.

The procedure for installing the fused-silica capillary tube, with safety 
sleeve, in the H-ESI probe is described in the Finnigan H-ESI Probe 
Operator’s Manual.
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Plumbing Connections for H-ESI/MS
Plumbing Connection
Diagrams for H-ESI/MS

The following H-ESI/MS plumbing diagrams are shown on pages 12-6 to 
12-10.

The following H-ESI/MS plumbing diagrams are shown in this topic:

• Figure 12-1. Plumbing diagram showing H-ESI/MS sample 
introduction from the syringe pump

• Figure 12-2. Plumbing diagram showing H-ESI/MS sample 
introduction from the syringe pump connected via an LC TEE union 
into the solvent flow from an LC

• Figure 12-3. Plumbing diagram showing H-ESI/MS sample 
introduction by loop injection into the solvent flow from an LC

• Figure 12-4. Plumbing diagram showing H-ESI/MS sample 
introduction from an LC autosampler with or without chromatographic 
separation

• Figure 12-5. Plumbing diagram showing H-ESI/MS sample 
introduction by auto loop injection into the solvent flow from an LC
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Figure 12-1. Plumbing diagram showing H-ESI/MS sample introduction from the syringe pump
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Figure 12-2. Plumbing diagram showing H-ESI/MS sample introduction from the syringe pump connected via an LC TEE union into the solvent flow from an LC

Drain to Waste Container: Prevent solvent waste from
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H-ESI Operation:  For installation, operation, and 

maintenance instructions, refer to the Finnigan

H-ESI Probe Operator’s Manual.
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Figure 12-3. Plumbing diagram showing H-ESI/MS sample introduction by loop injection into the solvent flow from an LC
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Figure 12-4. Plumbing diagram showing H-ESI/MS sample introduction from an LC autosampler with or without chromatographic separation
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Figure 12-5. Plumbing diagram showing H-ESI/MS sample introduction by loop injection into the solvent flow from an LC
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H-ESI Operation:  For installation, operation, and 

maintenance instructions, refer to the Finnigan

H-ESI Probe Operator’s Manual.
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Making Plumbing Connections to Run Samples on the TSQ Quantum Ultra
Plumbing Connections for APCI/MS
 Plumbing
Connections for

APCI/MS

If you need to install or replace the APCI source probe components, refer to 
the instructions in the Finnigan Ion Max API Source Hardware Manual.

The following APCI/MS plumbing diagrams are shown on pages 12-12 to 
12-14:

• Figure 12-6. Plumbing diagram showing APCI/MS sample 
introduction from the syringe pump connected via an LC TEE into the 
solvent flow from an LC

• Figure 12-7. Plumbing diagram showing APCI/MS sample 
introduction by loop injection into the solvent flow from an LC

• Figure 12-8. Plumbing diagram showing APCI/MS sample 
introduction from an LC autosampler with or without chromatographic 
separation
Thermo Electron Corporation Finnigan TSQ Quantum Ultra Getting Connected 12-11
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Figure 12-6. Plumbing diagram, showing APCI/MS sample introduction from the syringe pump connected via an LC TEE into the solvent flow from an LC

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.

1

2
3

4

5

To Waste

From LC

To LC Tee

Union

Plug 

(optional)

LC Tee Union

(00101-18204)

To LC Union

Fingertight

Fittings

(00101-18081)

Stainless Steel

Ferrule

(2522-3830)

Infusion Line

Fused-Silica Capillary

(00106-10504)

PEEK Tubing

(00301-22912)

To Divert /

Inject Valve

Ferrules

(00101-18196)

Ferrules

(00101-18120)

Stainless

Steel Nut

(2522-0066)

Fingertight

Fitting

(00101-18195)

PEEK Tubing

(00301-22912)

Grounding

Union

L
C

 U
n

io
n

(0
0

1
0

1
-1

8
2

0
2

)

F
e

rr
u

le

(0
0
1
0
1
-1

8
1
9
6
)

T
e

fl
o

n
 T

u
b

e

(0
0
3
0
1
-2

2
9
1
5
)

F
in

g
e

rt
ig

h
t 

fi
tt

in
g

(0
0

1
0

1
-1

8
0

8
1

)



Thermo Electron Corporation Finnigan TSQ Quantum Ultra Getting Connected 12-13

Figure 12-7. Plumbing diagram, showing APCI/MS sample introduction by loop injection into the solvent flow from an LC

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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Figure 12-8. Plumbing diagram, showing APCI/MS sample introduction from an LC autosampler with or without chromatographic separation

Drain to Waste Container:  Prevent solvent waste from

backing up into the API source and into the mass

spectrometer.  Always ensure that the drain hose is 

above the liquid level in the waste container.
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Index: #
Index

#
2-wire trigger (contact closure), connection for

Agilent 1100 Series Autosampler (table), 7-3
Gilson 215 Liquid Handler (table), 9-2
HP 1050 Series Autosampler (table), 6-3
HP 1090 Series LC (table), 6-7
HP 1100 Series Autosampler (table), 6-12
inlet devices not suported by Xcalibur (table), 3-4
terminal panel interface (table), 10-4, 10-5
Waters Alliance 2690 Separations Module (table), 8-3

4-Port Serial PCB, 11-1
installing, 11-1

A
Agilent 1100 Series LC

firmware (table), 7-1
analytical techniques

H-ESI/MS and APCI/MS (table), 12-1
APCI/MS

plumbing connections, 12-11

C
cable diagrams

SpectraSYSTEM LC
equipped with UV2000, 5-4
equipped with UV6000LP, 5-7

Surveyor LC System, 4-5
cables

Ethernet, 1-6
Cautions

CMOS maximum voltage, 3-2
SN4000 power supply, 5-3, 5-6
solvent waste backing into API source, 2-2, 2-3
venting APCI source, 2-3
venting H-ESI source, 2-2
wear grounding strap to handle PCI-GPIB PCB, 6-15

configuring
Agilent 1100 Series Autosampler, 7-3
Gilson 215 Liquid Handler, 9-2
HP 1050 Series Autosampler, 6-3
HP 1090 Series LC, 6-7
HP 1100 Series Autosampler, 6-13
SN4000 (figure), 5-5, 5-8
SpectraSYSTEM autosampler, 5-10
SpectraSYSTEM pump, 5-10
Waters Alliance 2690 Separations Module (figure), 8-3

connecting
4-Port Serial PCB, 11-1
SS420x, 10-1

Contact Closure Wiring Harness, 5-3

E
Ethernet cards

configuring, 4-5
data system computer, 4-6

F
Figures

cable diagram, Surveyor LC System, 4-5
contact closure, 3-2
HP1050 Series Autosampler dialog box, 6-4
HP1050 Series Autosampler rear panel, 6-3
HP1090 Series LC dialog box, 6-8
plumbing diagram for APCI/MS

from LC autosampler, 12-14
LC TEE, 12-12
loop injection, 12-13

plumbing diagram for H-ESI/MS
auto loop Injection, 12-10
LC flow, 12-9
LC TEE, 12-7
loop injection, 12-8
syringe pump, 12-6

Run Sequence dialog box, 3-5
SN4000 Configuration dialog box, 5-5
SpectraSYSTEM

Pump Configuration dialog box, 5-11
UV2000, cable connections, 5-4
UV6000 Configuration dialog box, 5-9
UV6000LP cable connections, 5-7
lectron Corporation Finnigan TSQ Quantum Ultra Getting Connected I



II

Index: G
Surveyor
flow cell plumbing, 4-10
LC Pump plumbing, 4-9
LC System plumbing, 4-8
MS Pump plumbing, 4-9

firmware
Agilent 1100 Series LC (table), 7-1
Gilson 215 Liquid Handler, 9-1
Gilson 819 Valve Actuator, 9-1
HP 1050 Series LC (table), 6-2
HP 1090 Series LC (table), 6-6
HP 1100 Series LC (table), 6-10
SN4000, 5-3, 5-6
SpectraSYSTEM LC (table), 5-1
Waters Alliance 2690 Separations Module (table), 8-2

G
gases

helium, 1-4
nitrogen, 1-4
requirements, 1-4

Gilson 215 Liquid Handler, 9-1
Xcalibur Gilson Interface Kit, 3-3, 9-1

GPIB, address for
HP 1050 Series LC (table), 6-2
HP 1090 Series LC (figure), 6-8
HP 1090 Series LC (table), 6-6
HP 1100 Series LC (table), 6-10

H
H-ESI/MS

metal needle kit, 12-4
plumbing connections, 12-4

HP
1050 Series LC

firmware (table), 6-2
GPIB address for (table), 6-2
reference manuals, 6-2
Xcalibur HP 1050 Interface Kit, 3-3, 6-1

1090 Series LC
firmware (table), 6-6
GPIB address for (table), 6-6
reference manuals, 6-6
Xcalibur HP 1090 Interface Kit, 3-3, 6-1

1100 Series LC
firmware (table), 6-10
GPIB address for (table), 6-10
Xcalibur HP 1100 Interface Kit, 3-3, 6-1

I
I/O panel schematic, TSQ Quantum Ultra (figure), 3-2
interface kits, for

additional 4-Port Serial PCB, 3-3, 11-1
contact closure, 3-3
Gilson, 9-1
Gilson 215 Liquid Handler, 3-3
HP

1050, 3-3, 6-1
1090, 3-3, 6-1
1100, 3-3, 6-1

SpectraSYSTEM LC, 3-3, 5-1
SS420x, 3-3, 8-1, 10-1
Waters LC, 3-3, 8-1

N
Notes

4-Port Serial PC, 11-2
efficient fume exhaust system, 1-3
ground loops, 3-2
NI-488.2 driver, 6-15
power conditioning devices, 1-2
replacing APCI sample tube, 2-3
SS420x, contact closure, 10-7, 10-9

P
parts, frequently used for plumbing (table), 12-2
PCI-GPIB PCB

installing and configuring, 6-15
power conditioning devices (note), 1-2
probe

APCI, connecting, 2-3
H-ESI, connecting, 2-2

R
reference manuals

Gilson 215 Liquid Handler, 9-1
HP 1050 Series LC, 6-2
HP 1090 Series LC, 6-6
PCI-GBIP PCB, 6-2
SpectraSYSTEM, 5-2
Waters Alliance 2690 Separations Module, 8-2

rotary-vane pumps, 1-3
Finnigan TSQ Quantum Ultra Getting Connected Thermo Electron Corporation
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Index: S
S
SN4000

configuring (figure), 5-5, 5-8
connecting

UV2000, 5-3
UV6000LP, 5-6

SpectraSYSTEM LC
components, 5-1
equipped with UV2000 (figure), 5-4
equipped with UV6000LP (figure), 5-7
firmware (table), 5-1
reference manuals, 5-2
Xcalibur Thermo Electron Finnigan Interface Kit, 3-3, 

5-1
SS420x

configuring, 10-3
connecting Waters 2487 Dual Wavelength Absorbance 

Detector (table), 8-5
installing, 10-2
Interface Kit, 10-1
wiring scheme (table), 10-3
Xcalibur SS420x Interface Kit, 3-3, 8-1

Surveyor autosampler
hardware connections, 4-2
installation, 4-2
plumbing, 4-7
plumbing (figure), 4-10

Surveyor flow cell
plumbing (figure), 4-10

Surveyor LC Pump
plumbing, 4-7

Surveyor LC System
cable diagram (figure), 4-5
figure, 4-2
plumbing (figure), 4-8
plumbing modules, 4-7

Surveyor MS Pump
plumbing, 4-7

T
TCP/IP address for

Agilent 1100 Series Autosampler (figure), 7-5

W
Waters Alliance 2690 Separations Module, 8-2

components, 8-1
firmware (table), 8-2
Xcalibur Waters Interface Kit, 3-3, 8-1

X
Xcalibur

Contact Closure Kit, 3-3
kits for inlet devices (table), 3-3

Xcalibur data system
inlet devices

controlled by, 3-2
not controlled by, 3-4

Run Sequence dialog box (figure), 3-5
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